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ABOUT SMASHING MAGAZINE

Smashing Magazine is an online magazine dedicated to Web designers and 
developers worldwide. Its rigorous quality control and thorough editorial 
work has gathered a devoted community exceeding half a million 
subscribers, followers and fans. Each and every published article is carefully 
prepared, edited, reviewed and curated according to the high quality 
standards set in Smashing Magazine's own publishing policy. Smashing 
Magazine publishes articles on a daily basis with topics ranging from 
business, visual design, typography, front-end as well as back-end 
development, all the way to usability and user experience design. The 
magazine is — and always has been — a professional and independent 
online publication neither controlled nor influenced by any third parties, 
delivering content in the best interest of its readers. These guidelines are 
continually revised and updated to assure that the quality of the published 
content is never compromised.

ABOUT SMASHING MEDIA GMBH

Smashing Media GmbH is one of the world's leading online publishing 
companies in the field of Web design. Founded in 2009 by Sven Lennartz 
and Vitaly Friedman, the company's headquarters is situated in southern 
Germany, in the sunny city of Freiburg im Breisgau. Smashing Media's lead 
publication, Smashing Magazine, has gained worldwide attention since its 
emergence back in 2006, and is supported by the vast, global Smashing 
community and readership. Smashing Magazine had proven to be a 
trustworthy online source containing high quality articles on progressive 
design and coding techniques as well as recent developments in the Web 
design industry.
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About this eBook
Like most elements (such as typography, color, layout and content), 
photography is a crucial component on interfaces and for websites. This is 
one of the reasons why new tools are created by heavy users of Photoshop. 
This eBook "Mastering Photoshop, Vol.3" offers hints for recent techniques, 
such as using brush tools, anti-aliasing typography, layer and grid settings, 
unveiling masks and perfecting pixels.
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Brushing Up On Photoshop’s Brush Tool
Tom Giannattasio

When laid by a learned hand, brush strokes can convey a sense of energy, 
tactility and humanness. These qualities speak to your audience’s 
subconscious, whispering ideas that words alone can’t convey. In the digital 
realm, a website with beautiful brushwork is a welcome break from the stark 
precision of most corporate websites.

Mastering the digital brush is by no means easy. It carries the same 
difficulties as the sable brush hidden at the bottom of your art bin. In fact, the 
difficulty is multiplied by the disconnect between the hand and monitor. 
Developing Photoshop brush skills takes time, but it is well worth the effort. 
This article outlines the plethora of options that Photoshop affords, so 
that you can efficiently create and use brushes like the Old Masters.
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Basic Se!ings
Along the brush’s options bar are some simple yet powerful settings that 
determine the strength and shape of your brush. These settings have a large 
impact on the how the brush applies paint, so they’re definitely important to 
understand.

The brush’s most essential settings are found in the options bar.

BRUSH

The brush menu, which is accessible by clicking the drop-down menu next 
to the brush preview or by right-clicking within the canvas, presents three 
options to control the shape of your brush: “Master Diameter,” “Hardness” 
and “Brush Shape.”
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The Master Diameter setting sets the overall width and height of your brush 
in pixels. It’s hard to notice on a standard round brush, but making a brush 
larger than its original size can cause it to become blurry. So, if you want to 
maintain clean edges, keep an eye on the brush’s original diameter. This 
setting is easily controlled using a couple of shortcuts. You can use [ and ] to 
modify the diameter in increments of 10 pixels, or you can use the on-canvas 
drag method: with your mouse cursor inside the canvas, hold down Option + 
Control + Shift and drag the mouse left or right. The brush will change in size 
as you scrub back and forth. This is great for when you need a precise size 
on the fly.

The brush menu is easily accessible by right-clicking on the canvas.
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The hardness setting is available only for Photoshop’s round brushes. 
Setting the hardness as a percentage from 0 to 100 will feather the edges of 
the brush; 100% is a crisp edge, and 0% is a completely feathered edge from 
the center of the brush to the circumference. For broad alterations to this 
setting, use the keyboard shortcuts Shift + ] and Shift + [ to change the 
values in 25% increments, or you can hold Command + Option + Control and 
drag inside the canvas to change the values and see them take effect as 
you do it.

The on-canvas drag shortcuts make diameter and hardness adjustments simple 
and intuitive.
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At the bottom of the panel is an assortment of brush presets, which gives 
you quick access to the brushes you use most. Some of the defaults are just 
simple shapes and textures, but others have been customized with 
advanced settings in the Brushes palette (F5). Photoshop has a number of 
brush libraries that can be added to the list using the panel's fly-out menu, 
but you can also load and create custom brushes (see "Managing Presets" 
below).

Photoshop provides a dozen additional brush libraries, which can be found in the 
brush menu's fly-out.
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MODE

The brush's mode sets how painted pixels affect those already on the 
current layer. These modes work in the same way that Blend Modes work on 
the layer's palette, except that they're converted to absolute values when 
the stroke is finished. This is an important distinction to make: once you've 
painted using a blending mode, that mode cannot be altered after the fact 
as you would using blending modes on the layer's palette.

Setting the mode changes how the paint affects the layer's current pixels.
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The brush tool also introduces two blending modes not found in the layer's 
palette: "Behind" and "Clear." The Behind setting allows you to paint only in 
the areas of the layer that are transparent; this can be helpful if you need to 
paint behind a subject and leave filled pixels intact. The Clear setting 
essentially turns the brush into an eraser; instead of adding paint to the 
layer, it removes it.

The Behind mode allows you to paint strictly in transparent areas. Clear mode 
essentially turns your brush into an eraser.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 11



OPACITY, FLOW AND AIRBRUSH

These three settings work in unison to determine the amount of paint laid on 
the canvas. The opacity setting is the master control; it sets the maximum 
amount that can be painted with each stroke, mouse down to mouse up, 
regardless of any other setting.

Flow, on the other hand, sets the amount of paint applied to an area every 
time the brush moves. So, if your Flow setting is set to 20%, and you click 
one area of the layer, only 20% will be painted. However, if you move the 
mouse back and forth over an area with the same setting, the paint will build 
up incrementally by 20%.

Finally, the Airbrush setting allows you to build up paint based on time 
instead of movement; by simply holding the mouse down in one area, you 
can multiply the brush's effect. You can quickly set the Opacity of a brush 
using the number keys (5 is 50%, 65 is 65%). By holding Shift while inputing 
the numbers, you can control the brush's Fill setting. Note: if the Airbrush 
setting is on, these two shortcuts are reversed.
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Opacity and Flow both control the brush's transparency but are very different.

Advanced Se!ings
Within the Brushes palette (F5) are dozens of settings that control the way 
the brush paints, from shape and size to flow and scatter. Understanding 
how to use these options is the key to creating wonderful brushes.
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BRUSH PRESETS

The Brush Presets menu lists all of the currently available brushes. While 
some of the presets simply change the shape of the brush, others have 
advanced settings.

The brushes in the Brush Presets list are not just brush shapes; some also have 
advanced settings.
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Photoshop contains a number of brush libraries in addition to the defaults, 
which can be easily appended to the current list of presets. These presets 
are accessible in the fly-out menus located in the Brushes Palette and in the 
Brush drop-down menu in the toolbar. Photoshop provides a dozen or so 
libraries, including Calligraphic, Dry Media, Wet Media and Natural, but you 
can also load a custom library by choosing "Load Brushes…"

If you've created a brush that you would like to save as your own custom 
preset, you can do so by clicking the Create New Brush button at the 
bottom of the palette. This will add the brush to your preset menu; however, 
if the menu is reset, the brush will be lost. Luckily, Photoshop allows you to 
export a custom library so that you never lose your favorite brushes. Simply 
choose, "Save Brushes…" from the fly-out menu and you can export an .ABR 
file containing all of the brushes currently in the Brush Presets menu.

You can customize even further by creating your own custom brush shape. 
To do so, start by creating a selection of the area you'd like to create the 
brush sample from (or select the layer you'd like to use). Then, select Edit → 
Create Brush Preset… Name it and click "Okay." A new brush preset will be 
added to the menu.

Creating a custom brush shape is the first step in creating a completely unique 
brush.
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BRUSH TIP SHAPE

This group allows you to control the primary shape of the brush. Many of 
these settings, which are outlined above, are also found in the Brushes 
toolbar, but here we also have options for flipping, rotation, roundness and 
spacing. "Rotation," "Flip X" and "Flip Y" modify how the brush is oriented. 
Setting Roundness to lower than 100% will squish the brush along its original 
x-axis; this can be used to easily create a calligraphic brush. Adobe realized 
that Roundness and Rotation may be hard to visualize and so has added a 
more intuitive way to work with these settings: simply drag the arrow and 
control points on the image to the right, and the values will be updated.
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The Brush Tip Shape menu provides control of the primary shape of the brush.
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Photoshop scales brushes by interpolating them up or down; no vector 
brushes are available. Therefore, some brushes may become gritty or 
pixelated if scaled too much. To quickly return a brush to its original size, 
click the Use Sample Size button.

Over-sizing a brush can cause unwanted pixellation. This can be remedied with 

the Use Sample Size button.
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The final setting in this group is Spacing, which determines how often the 
brush is sampled onto the layer. Lower values place the samples close 
together, and higher values space them out. Spacing not only changes the 
stroke's appearance but can drastically affect Photoshop's performance. 
Setting it to 1% can produce smoother edges, but a large or complex brush 
can seriously bog Photoshop down. If performance is an issue, keep this 
setting as high as you possibly can. Spacing can also be turned off using the 
checkbox next to its name. This causes the brush to sample with 
inconsistent spacing, based on the speed of your movements.

Spacing has a large effect on the smoothness of your brush but can also impact 
rendering speed.
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BRUSH CONTROL METHODS

A number of the settings in the Brushes palette allow you to set a method 
for controlling values. They include "Off," "Fade," "Pen Pressure," "Pen Tilt," 
"Stylus Wheel," "Rotation," "Initial Direction" and "Direction." Some of these 
settings require a tablet, such as a Wacom. If you don't have a tablet or if the 
method is not available with your particular stylus, Photoshop will display an 
error icon to notify you.

OFF

Control is completely negated with the Off setting, which means that values 
will remain consistent throughout the stroke of the brush.

Without a control set, each sample of the brush remains consistent.
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FADE

Using the Fade control allows you to specify the number of steps over which 
the setting will incrementally decrease until it reaches its minimum. So, by 
default, setting the Size control to Fade with 10 steps will cause the brush to 
decrease its size by 10% each step until the brush reaches 0. This can be 
used with the Size setting to effectively create individual strands of hair. 
While many of the settings allow you to specify the fade's minimum 
percentage, others use a preset amount. For example, setting steps for the 
Angle Fade specifies how many steps will be used to rotate the brush 360°.

The Fade Control incrementally decreases values until the minimum is reached.
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PEN PRESSURE

Pen Pressure is an extremely useful setting but requires a pressure-sensitive 
tablet device. It determines values based on how hard you press the pen to 
the pad. This makes for very intuitive painting especially when used on size 
and opacity settings.

Pen Pressure requires a tablet device and determines values based on how hard 
the stylus is pressed to the pad.
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PEN TILT

The Pen Tilt setting changes values based on the angle of the pen to the 
tablet. When the pen is perfectly perpendicular to the tablet, the variance is 
set to 0%. As you tilt the pen, the values increase. This setting is especially 
helpful for controlling the angle of the brush, because it also takes into 
consideration the direction in which the pen is pointing on the tablet. So, 
holding the pen at an angle and pointing it to the left side of the tablet will 
point the brush to the left.

By setting the Angle Control to Pen Tilt, you can match the brush tip's rotation to 
your hand's rotation.
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STYLUS WHEEL

If your stylus comes equipped with a Stylus Wheel, you can use it to control 
variance on the fly by rotating it. This may be helpful for quickly changing 
settings between strokes, but using to change values during a stroke is 
difficult.

If your pen has a stylus wheel, you can use it to control values.

ROTATION

This is another setting that requires a special type of stylus. If your stylus 
supports Rotation, you can simply rotate the stylus to control values. This is 
probably best used with the angle setting.

If your pen has a stylus wheel, you can use it to control values.
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INITIAL DIRECTION

When using the Initial Direction setting, the brush will not immediately start 
applying paint. Photoshop waits to see in which direction you move the 
brush and then rotates the brush based on the angle.

The first movement you make using the brush determines the angle when using 
the Initial Direction control.

DIRECTION

The Direction setting can be particularly useful for painting something like 
grass along a contour, because it will rotate based on the direction that your 
brush has traveled since the last step.

The Direction control rotates your brush so that it naturally follows the curve of 
the stroke.
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SHAPE DYNAMICS

Now that you have a basic shape and size set, you can add some variance 
using Shape Dynamics. Here you'll see three different types of jitters, which 
control the amount of variation allowed for size, angle and roundness. 
Setting any of these options to above 0% will cause the brush to sample at 
random values within the range set by the percentage (e.g. setting the Angle 
Jitter to 50% will limit the brush's rotation to 180°).

The Shape Dynamics' jitter controls can be used to add some variation to the 
brush shape.
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SCATTERING

The Scattering menu allows you to vary where each sample of the brush is 
placed and how many samples are placed per step. Three sliders are here 
for you to control: "Scatter," "Count" and "Count Jitter." The Scatter setting 
sets a percentage for how far off the origin the sample is allowed to travel. 
By default, this will control the variance only along the y-axis, but by clicking 
the "Both Axes" checkbox, you can set the same value for the x-axis.

Scattering can add a lively randomness to a stroke.
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Count and Count Jitter work together to determine how many samples are 
generated in every step. Count dictates the maximum number of samples 
allowed, while Count Jitter randomly chooses a number within that range to 
sample. If the Scatter setting is not set to above 0%, then the Count setting 
will place the brush on top of itself, which can create a "heavy" brush with 
jagged edges.

TEXTURE

Adding a texture to your brush can give a wonderful sense of depth. 
Photoshop allows you to apply any of your Texture presets to your brush. 
You can then modify the Scale or Invert it. The Mode drop-down menu 
provides a list of blending modes that determine how the texture mixes with 
the current values of the brush. Although most of these blending modes 
look familiar, they function a little differently here. For example, you would 
think that setting the Mode to Multiply on a brush that is completely black 
wouldn't have any effect. However, Photoshop compensates by reducing 
the original values of the brush so that the texture is visible.

At first, the Depth setting seems to work by setting the opacity of the 
texture. However, what it really does is ramp the values of the texture from 
their original grayscale values (at 100%) to completely white (0%). This allows 
for more dramatic results than simply reducing the texture's opacity.

This menu also has a feature, called "Texture Each Tip," that allows you to 
control the texture of every brush sample. Checking this option turns a 
couple of other sliders on, which set the Minimum Depth and Depth Jitter. 
Altering these values will cause each sample to have a random depth within 
the set range.
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Using a texture adds tactility and depth to each stroke.
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DUAL BRUSH

Combining two brushes using the Dual Brush option opens the door to 
some fantastic effects that you could never have created using a single 
brush. As the name implies, this setting uses two different brush shapes to 
create the final sample. The primary brush is basically used as the mask that 
the dual brush is contained within. The Dual Brush menu has a few settings 
for the second brush, which work in the same manner as they do for the 
primary brush. The differences you set in Shape, Spacing, Scattering, Count 
and Mode make for a more dynamic and naturally random brush stroke.

Combining brush shapes creates a unique effect that you couldn't have achieved 
otherwise.
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COLOR DYNAMICS

The Color Dynamics menu helps you interject some color variation into your 
brush strokes. You can control the colors by using the Foreground/
Background Jitter, or you can allow Photoshop to randomly select values 
using the Hue, Saturation and Brightness Jitters.

The Foreground/Background Jitter controls how much of the background 
color is allowed to be sampled into the brush. Note that the background 
color is added to, not substituted for, the foreground color. This means that 
if your foreground color is red and your background color is blue, the 
intermediary samples will be a purple hue.

The Foreground/Background Jitter randomly blends two colors together.
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The Hue, Saturation and Brightness Jitters determine the maximum amount 
of variance allowed based on the foreground color's values for each. So, if 
your foreground color has a saturation or brightness value of 0, then your 
brush strokes will be completely grayscale. At the other extreme, setting a 
foreground color with 100% brightness and saturation will make every 
possible color available to use.

Hue, Saturation and Brightness Jitters can be used to add variation to the 
foreground color's properties.
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In addition to the Jitter settings is a Purity slider. This sets how pure the 
saturation is for each sample. If set to 0%, it does nothing; if moved to 100%, 
it limits the Saturation value for each sample to 100%. However, this should 
not be mistaken as an overriding setting for saturation; it sets only 
thresholds for it. So, setting it to -50% would ensure that saturation values 
never go above 50%, and a setting of -100% would completely remove all 
saturation.

The Purity slider sets a threshold for each brush sample's saturation level.
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OTHER DYNAMICS

With the Other Dynamics menu, you can jitter and set controls for varying 
the brush's opacity and flow. Both of these jitters depend on the brush's 
current settings in the properties bar. They don't allow the brush to gain 
opacity; they only determine how much lower it can go. The pen pressure 
control is an intuitive match for either of these settings.

Opacity and Flow Jitters both change the transparency of each brush tip shape, 
but the Flow Jitter allows the samples to compound.
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OTHER SETTINGS

Noise

Generates random noise within the gray values of your brush shape.

Wet Edges

Decreases the interior values of your brush, while leaving the edges at full 
opacity. Doing so, the brush creates an effect similar to watercolor with its "wet 
edges."
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Airbrush
Allows paint to build up incrementally based on the Flow setting and limited 
by the Opacity setting (see Opacity, Flow and Airbrush above).

Smoothing
Smoothes the curves of the stroke to prevent polygonal curvatures. Turning 
this off may help if your brush is rendering slowly.

Protect Texture
Ensures that the same texture is used for every brush with a texture.

OTHER PALETTE OPTIONS

Lock Setting
Next to each menu name in the Brushes Palette is a padlock icon. These 
allow you to lock a setting so that when you switch to a different brush 
preset, the settings from that menu carry over to the new preset. This can be 
very helpful when you need a similar effect but don't want to have to rebuild 
it with a new brush shape.

Resetting
The Brushes Palette has two different ways to reset controls in its fly-out 
menu: "Clear Brush Controls" and "Reset All Locked Settings." Clear Brush 
Controls will turn off all controls except for Smoothing but keeps the locked 
settings locked. Reset All Locked Settings also turns off all controls but will 
also unlock everything.

Painting Quick Tips
Learning the technical aspects of the digital brush is only the first step in 
becoming a master brush artist. It also requires a bit of talent mixed in with 
never-ending practice. Here are some quick tips to help you along the way.
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CHANGING THE CURSOR

If you find that the normal cursor doesn't suit your liking, you may want to 
change it. In Photoshop's Preferences menu (Command + K) is a section 
called Cursors (Command + 5). Here you have the option to change the 
"Painting Cursor" from Normal Brush Tip to Standard, Precise or Full-Size 
Brush Tip. You can also create a hybrid cursor by using the Normal or Full-
Size Brush Tip in conjunction with the "Show Crosshair in Brush Tip" option. 
Below the Paint Cursors section is an option for the Brush Preview color. 
This is the color that is displayed when modifying the brush shape with the 
on-canvas drag shortcuts: Control + Option + Drag to change the diameter, 
and Control + Option + Command + Drag to change the hardness.

Changing the cursor may help you gain better control of the brush.
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PAINTING STRAIGHT LINES

Painting a freehand straight line is nearly impossible. Luckily, Photoshop has 
some features to help with this. By holding the Shift key while painting, your 
stroke will be constrained to 45° angles. Painting straight lines that aren't 
locked to 45° angles is just as easy. Start by clicking once on the beginning 
point of the line. Move the cursor to the end point, hold Shift and then click. 
A perfectly straight line will have been drawn between the two points.

Clicking to start a line and then holding Shift and clicking at the end of a line will 
paint a perfectly straight line between the two points.
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PAINTING PERFECT CURVES

Photoshop's Paths palette allows you to stroke a path using the current 
brush's settings. This can be extremely helpful if you have a tricky curve or 
complex shape to paint. First, set up your brush. Then, select the path you 
wish to stroke; and in the Paths palette, Option + Click the Stroke path with 
the brush button. This will present you with a dialog box that allows you to 
set the tool you want to stroke with. You can even use the Simulate 
Pressure button to activate any control methods you have set on your brush.

Stroking a path with your brush gives you perfect control over the stroke's 
curvatures.

OTHER "PAINTING" TOOLS

Remember that the Brush Tool is not the only tool that uses brush settings. 
By customizing these other tools, you can create some very impressive 
effects. The other "Painting" tools include: Pencil, Eraser, Background 
Eraser, Clone Stamp, Pattern Stamp, Healing Brush, History Brush, Art 
History Brush, Smudge, Blur, Sharpen, Dodge, Burn, Sponge, Color 
Replacement and Quick Selection.
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Keyboard Shortcuts

TOOL SELECTION

• B: Brush tool

• Shift + B: Rotate through Brush tools (i.e. Brush, Pencil and Color 
Replacement tools)

• F5: Show or hide Brushes palette

BRUSH SETTINGS

• [: Decrease brush diameter

• ]: Increase brush diameter

• Shift + [: Decrease brush hardness by 25%

• Shift + ]: Increase brush hardness by 25%

• Digit Combination (with airbrush off): Set the brush’s opacity

• Shift + Digit Combination (with airbrush off): Set the brush’s fill

• Digit Combination (with airbrush on): Set the brush’s fill

• Shift + Digit Combination (with airbrush on): Set the brush’s opacity

• Option + Shift + ‘+’: Next blending mode

• Option + Shift + ‘-’: Previous blending mode

• ,: Previous brush

• .: Next brush

• Shift + ,: First brush
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• Shift + .: Last brush

• Caps Lock: Toggles between Precise and Normal cursors

• Control + Click (inside canvas): Bring up the quick brush menu

• Control + Shift + Click (inside canvas): Brush blending mode menu

• Control + Option + Drag (inside canvas): Change the brush’s diameter

• Control + Option + Command + Drag (inside canvas): Change the 
brush’s hardness

PAINTING

• Shift + Drag: Constrain the brush to 45°

• Click, move cursor, then Shift + Click: Draw a straight line from the first 
click to the second click

HELPER TOOLS

• Option (hold): Temporarily switch to Eyedropper tool

• Shift + Option (hold): Temporarily switch to Color Sampler tool

• Command (hold): Temporarily switch to Move tool

• Command + Option (hold): Duplicate and Drag layer

• Space (hold): Temporarily switch to Hand tool
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Unveiling Photoshop Masks
Tom Giannattasio

Design is a fluid and shifting process in which layers are constantly modified 
and tweaked. As complexity builds, so does the need for preserving data in 
a flexible way. Learning non-destructive editing techniques helps you 
produce documents that bend along with your creativity. Photoshop Masks 
are the cornerstone of this process. Not only do they preserve important 
pixel data, but they allow for the creation of flexible interface elements as 
well. In this article, we’ll explore the technical aspects and creative 
advantages of incorporating masks into your workflow.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 42



Photoshop offers five methods of masking: Pixel Masks, Vector Masks, 
Quick Masks, Clipping Masks and Clipping Paths, all of which define pixel 
opacities without affecting the original data. Each of them has its own pros 
and cons, and knowing which method to use is extremely important for 
creating clean, flexible and properly masked layers.

Pixel Masks
Pixel masks determine opacity values based on a raster image with 
grayscale values that correspond pixel for pixel to the original layer. This 
makes them ideal for masking complex photographic imagery (e.g. the hair 
on a model or leaves on a tree). Pixel masks allow 100 shades of gray, which 
correspond directly to opacity percentages. The ability to vary opacities is 
unique to pixel masks, making them an invaluable tool.

Pixel Masks are ideal for extracting complex photographic imagery. (Image 
Source)
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While pixel masks can be easily modified, they aren’t ideal for every 
situation. Because of their raster format, scaling them can cause unwanted 
artifacts and interpolated blurriness. Smooth curves and perfect edges can 
also be tricky to create when painting a mask. Under such circumstances, 
vector masks would be preferable.

Pixel masks should not be used when you might have to rescale.
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CREATION

Creating a pixel mask is as easy as selecting the layer or layer group and 
clicking the “Add Layer Mask” button at the bottom of the layer’s palette. A 
second thumbnail will be added to the layer, giving you a preview of the 
mask. By default, this will be entirely white. However, if you happen to have 
a selection active when creating the mask, the selection will be used to 
define the grayscale values of the mask.

Once a mask is created, it can be edited as if it were any other pixel data by 
clicking on the mask’s thumbnail. You can then paint in black to hide areas 
or white to show them. The mask can also be tweaked using adjustments 
and filters such as Curves, Threshold, Unsharp mask and Gaussian blur.

Painting the mask black is much like using the eraser tool. (Image Source)
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VIEW MODES

While creating a mask, there are a number of ways to view the mask data. 
Option + clicking on the thumbnail will display only the mask on the canvas; 
this is great for fine-tuning areas but doesn’t allow you to see the actual 
layer as you work. If you’d like to see both the mask and the layer at the 
same time, you can view the mask as a Ruby overlay. Simply press \ with the 
layer selected to toggle the overlay on and off. The color and opacity of the 
overlay can also be changed by double-clicking the mask’s thumbnail. 
Additionally, if you’d like to temporarily remove the mask, you can toggle it 
on and off by Shift + clicking on the mask’s thumbnail.

Turning the mask off and the overlay on can help with fine-tuning. (Image Source)
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CHANNELS

Every time a layer with a mask is selected, the mask is shown as a 
temporary alpha channel in the Channels palette. From here, you can save 
the channel for later use by dragging the channel to the “Create new 
channel” button at the bottom of the palette or by selecting “New Channel” 
from the fly-out menu. You can also change the mask’s Ruby overlay 
settings by double-clicking the channel’s thumbnail. Because a temporary 
channel becomes available whenever a masked layer is selected, you can 
use some keyboard shortcuts to toggle between the actual layer and its 
mask. Pressing Command + \ will select the mask and Command + 2 will 
bring you back to the layer data.

A temporary channel is available whenever a layer with a mask is selected.
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VECTOR MASKS

Vector masks pick up where pixel masks fall short. By defining the mask’s 
shape using paths, vector masks provide a superior level of finesse and 
flexibility. They’re ideal for defining shapes with clean, crisp lines, such as 
interface elements.

Vector Masks are ideal for masking crisp-edged objects. (Image Source)
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The disadvantage of vector masks is that they are unable to vary pixel 
opacities; they are basically either 0 or 100. For this reason, many masking 
jobs require a hybrid implementation. By using a vector mask to define the 
solid edges and a pixel mask for the more complex areas or for varying 
opacities, you can effectively extract objects while maximizing flexibility.

CREATION

To add a vector mask to an existing layer, simply Command + Click the “Add 
Layer Mask” button at the bottom of the layer’s palette. If a path is currently 
active, the mask will be created using it. Otherwise, the mask will be empty. 
Paths can then be added, subtracted or modified by clicking the mask’s 
thumbnail.

Being able to create flexible interface elements is one of the best 
advantages of vector masks. Using the Shape Tool (U) set to Shape Layers 
allows you to quickly create a fill layer with a Vector Mask. These layers are 
far more flexible than a raster level and are perfect for creating buttons, 
rules and other elements that can be resized without interpolating data.

The flexibility offered by Vector Masks make them perfect for interface elements 
such as buttons.
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VIEW MODES

By clicking on the Vector Mask’s thumbnail in the the Layer’s palette, you 
can show or hide the paths saved in the mask. These paths can also be 
accessed from the Path’s palette, but only if the layer itself is selected. 
Toggling the mask on and off can be done by Shift + clicking the thumbnail.

PATHS

Much like how layer masks appear in the Channels palette, a temporary 
work path would be displayed in the Paths palette when a layer with a 
vector mask is selected. You can then save the mask by dragging it to the 
“Create new path” button at the bottom of the palette or selecting “Save 
Path” from the fly-out menu. This temporary path can be accessed at any 
time by first selecting the Path Selection tool (A) and then pressing Enter; it 
can be dismissed by pressing Enter again. You can also quickly create a 
selection from an active path by pressing Command + Enter.

APPLYING

Before a vector mask can be applied to a layer it must first be rasterized by 
right-clicking the vector mask thumbnail and choosing Rasterize Vector 
Mask. If the layer already has a pixel mask, the two masks will be 
composited together to create a single pixel mask. It can then be applied 
like any other layer mask (right-clicking the thumbnail and choosing “Apply 
Layer Mask”).
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Quick M asks
The Quick Mask mode allows you to create a selection using pixel editing 
tools as opposed to the primitive selection tools. This is a more logical 
approach to creating a complex mask with variable opacity. You can access 
this mode by clicking on the “Quick Mask” button in the Tools bar or by 
pressing Q.

Once in Quick Mask mode, you’ll no longer be editing the current layer. 
Instead, you’ll be editing a Ruby overlay that can be edited as if it were 
regular pixel data. By default, entering this mode will cover the entire canvas 
with a semi-transparent red color. You can then paint white to remove the 
overlay and black to add it back. The Quick Mask is essentially a more visual 
representation of a selection. Therefore, every area that you remove from 
the overlay is added to the selection.

Quick Mask mode allows you to quickly paint a selection. (Image Source)
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OPTIONS

You can modify how the Quick Mask mode is displayed by double-clicking 
the “Quick Mask” button in the Tools bar. Here you can change the color 
and opacity of the mask as well as whether the mask color indicates masked 
areas or selected areas. Personally, I find painting selected areas more 
intuitive than painting masked areas, which is the default.

The Quick Mask Options menu allows you to change the color, opacity and target 
of the overlay.
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SAVING

After creating a quick mask, you can immediately apply it to a layer by 
creating a layer mask or save it for later use. By selecting Selection → Save 
Selection, you can save your selection as a new channel or apply it to an 
existing channel. This allows you to come back to the selection at any time 
by Control + clicking the channel in the Channel’s palette or by selecting 
Selection → Load Selection

Saving a Quick Mask creates a new channel.
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Clipping Masks
You’ll often run into situations in which multiple layers require the same 
mask. You could group the layers and mask the layer group, but that is not 
always ideal. Clipping masks allows for a layer simply to adopt the opacity 
of an underlying layer. This is extremely helpful when using adjustment 
layers; by clipping them to a layer, you can apply adjustments to a single 
layer without affecting those below it.

The easiest way to create a clipping mask is to Option + click between the 
two layers in the Layer’s palette when the clipping mask cursor appears. 
Alternatively, you could press Command + Option + G to clip a layer to the 
one below it. Any number of layers can be clipped to one master layer, but a 
clipped layer can’t be used as a clipping mask itself.

Clipping Masks are great for constraining Adjustment Layers. (Image Source)
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Clipping Paths
Clipping Paths are a lot like Vector Masks except that they apply to an 
entire document rather than a layer or layer group. They are primarily used 
by print designers to specify uniquely shaped objects that are imported into 
a page layout program. The path is imported along with the image to ensure 
a crisp clean edge.

To create a clipping path, first be sure that you have a path saved; having a 
temporary Work Path does not suffice. You must select “Save Path” from the 
fly-out menu in the Paths palette if your path is not saved. Then, from the fly-
out menu, choose “Clipping Path.” Your document’s appearance will not 
change, but if you were to import the document into Illustrator using the 
Place command, it would be clipped to the path.
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Masks Pale!e
The Masks palette, introduced in CS4, adds some useful features to help 
with creating and refining both pixel and vector masks. For the first time, 
you can feather a mask and change its density without losing the original 
mask.

The Masks palette was a great addition to Photoshop CS4.
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CREATE/VIEW BUTTONS

At the top of the palette are two buttons that can be used to select the layer 
mask or vector mask or to create one if one doesn’t exist.

DENSITY

The density slider basically controls how strong the mask is. At 100%, fully 
masked areas will be completely transparent. When density is set to 50%, 
those same areas would be only 50% transparent.

The Density slider controls the strength of the mask. (Image Source)
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FEATHER

Feathering the edges of a mask used to require applying a Gaussian Blur, 
which would destroy the original mask shape. With the Masks palette you 
can now change the amount of feathering at any time while maintaining 
the original mask data.

With the Feather slider, you can now change the mask’s softness on the fly. 
(Image Source)
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MASK EDGE

The Mask Edge menu provides some long-desired features that aid in 
refining a mask’s perimeter. They come in extremely handy when the 
extracted object is still picking up color from the masked background.

Radius
The Radius setting is similar to feathering, but it retains some of the edge’s 
crispness. This can be helpful with reducing awkward or overly sharp edges 
on complex shapes.

Contrast
Contrast simply modifies the contrast of edge elements, which helps crispen 
any soft edges. Using this in conjunction with Radius can help remove 
unwanted artifacts in the mask.

Radius and Contrast can be used to remove unwanted artifacts. (Image Source)
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Smooth
Smooth simplifies the complexity of the mask’s edges. This can be useful if 
you’ve painted the mask by hand and need to quickly clean up some rough 
edges.

Feather
This feather command is nearly identical to the Mask palette’s primary 
feather command, but it restricts the blur more to the edge of the mask. The 
difference is slight yet noticeable.

Contract/Expand
The Contract and Expand slider allows you to grow and shrink the edges of 
the mask. This is extremely useful for reducing unwanted color fringes.

Smooth and Contract helps tighten up masks to reduce color fringes. (Image 
Source)
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Preview Mode
At the bottom of the palette are five different preview modes that allow you 
to view the mask as a (1) selection with marching ants, (2) quick mask ruby 
overlay, (3) black matte, (4) white matte or (5) grayscale mask.

Check the mask in different views to ensure its quality. (Image Source)

COLOR RANGE

The Color Range menu is one of the most powerful ways to extract an image 
from an evenly colored background. With only a few clicks and adjustments, 
even the most complex object can be cleanly masked. For further details, 
see the “Techniques” section just below.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 61

http://www.sxc.hu/photo/1245941
http://www.sxc.hu/photo/1245941


Techniques
Each masking job is unique and requires a different method of creation and 
refinement. However, some common techniques can drastically improve the 
efficiency and maximize the flexibility of your masks.

COLOR RANGE

When your masking task requires an object to be extracted from an evenly 
colored background (much like the video editing process of Chroma keying), 
the quickest means is often the Color Range command. First, use the 
Eyedropper Tool to select the primary color of the background. Then, you 
can use the “Add to sample” and “Remove from sample” tools to refine the 
color selection. The fuzziness slider lets you broaden the range of colors 
selected. If the color data is there to support it, this process makes short 
work of an otherwise tedious task.
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The Eyedropper tools allow you to easily select the sky in the photo.
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Color Range can make quick work of complex masks. (Image Source)
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CHANNELS

A mask is often hiding in one of the layer’s channels, just waiting to be 
unlocked. Depending on the image you’re using, you may be able to find a 
channel with strong contrast between the target object and its surroundings. 
You may even want to try temporarily changing the color mode to Lab or 
CMYK to provide alternative channel options. Once you find a channel with 
a strong enough contrast, Command + click it to create a selection. Then, 
apply the selection as a layer mask. You’ll then be able to tweak it as you 
would any other mask.

As the image below demonstrates, simply selecting a channel is not always 
sufficient for a clean mask. You may need to do some mixing with other 
channels.
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(Image Source)
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1. The original image has strong vibrant colors, making it a great 
opportunity to create a mask using channels.

2. The red channel has the foreground-to-background contrast, so we’ll 
start there. We’ve copied and pasted it onto a new layer and then 
inverted it.

3. The green cup is still very prominent, so we’ve converted the blue 
channel to a layer and will use it to negate the green and red cups.

4. By setting the Blending Mode on the blue channel’s layer to Multiply, 
we can effectively erase any extraneous white areas.

5. The two layers are then flattened and applied as a layer mask to the 
original image. This leaves us with a cleanly masked blue mug.

PIXEL/VECTOR HYBRID

Objects will quite often have a combination of sharp edges and soft 
feathered edges. In instances like these, using both a pixel and a vector 
mask may be best. One common example of this is extracting a figure. You 
can use the pen tool to draw all of the smooth edges along the figure’s body 
and then use a pixel mask to paint in the fine details such as hair.
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MULTIPLE MASKS

There may be times when you want to apply more than one mask to a layer. 
You could choose to apply the mask by right-clicking the layer and selecting 
Apply Layer Mask, after which you could apply a new mask. This, however, 
is not ideal because the data behind the mask will be lost.

A far better method is to create a Smart Object from the layer and mask 
the new layer. This allows you to apply two masks to one layer without 
losing data. In fact, if needed, you could repeat this process over and over.

Converting a layer to a Smart Object allows you to add multiple masks without 
losing data.
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LAYER STYLES

If you have ever added a mask to a layer with layer styles, things may have 
gotten messy, especially if the mask had soft edges or varying opacities. 
This is because, by default, Photoshop uses a composite of the layer’s 
opacity along with any masks on it to define the area used by the layer 
styles. This is desirable but can also be a nuisance. To counter the default 
behavior, open the Blending Options menu for the layer, and apply either 
“Layer Mask Hides Effects” or “Vector Mask Hides Effects.”

Messes can often be tidied by using the “Layer Mask Hides Effects” option.
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BLEND CLIPPED LAYERS AS GROUP

By default, Photoshop assumes that all layers in a clipping stack should be 
blended with the base layer before the base layer is blended with the layers 
below it. This makes sense sometimes, but other times you may need the 
clipped layers to adopt the shape of the base layer but not the blend mode. 
To prevent this behavior, open the Blending Options menu for the base 
layer (right-click the layer and choose “Blending Options”), and uncheck the 
“Blend Clipped Layers as Group” option. Now, each of the clipped layers will 
blend with underlying layers as if they weren’t clipped.

The “Blend Clipped Layers as Group” causes all clipped layers to blend together 
first and then blend with underlying layers using the base layer’s Blend Mode.
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TYPE MASKS

Grouped with the Type tool in the Tools bar is the deceptively named Type 
Mask tool. It allows you to create type just like the regular type tool; but 
once committed, the type is converted to a selection. This selection can be 
converted to a layer mask but will no longer be editable. This is not ideal. If 
editability is important, you may want to create a regular type layer and use 
it as the base of a clipping mask. This is the only way to mask objects to the 
shape of type without losing the ability to edit the text. Perhaps someday 
Photoshop will let us create an editable Type Mask for a layer.
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REMOVING EDGE FRINGES

Even after using the “Refine Edge” command in the Masks palette, you may 
find random color fringes left along the edge of your mask. This is where 
some manual brushwork comes in handy. The Paintbrush tool can be used 
here, but I recommend the Healing Brush, Stamp Tool or Smudge Tool 
because they will blend better with the subject.

First, create a new layer and clip it to the masked layer. Then, set your tool 
of choice to sample all layers. You can now select your sample area and 
paint the fringes out; the original layer data will be preserved. Often, 
changing the brush’s Blend Mode will help preserve the detail of the layer.

Color Fringes can usually be smudged or painted away on a clipped layer. 
(Image Source)
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Keyboard Shortcuts
• \

View Layer Mask as an overlay

• Command + \
Set layer focus to Layer Mask

• Command + 2
Set layer focus to layer data

• Command + Option + \
Create selection from Layer Mask

• Command + Option + G
Make/Release Clipping Mask

• A, then Enter
Activate/Dismiss Vector Mask

• Command + Enter
Create selection from active vector mask

• Command + Click Mask Thumbnail
Create selection from mask

• Command + Option + Click Mask Thumbnail
Subtract mask from selection

• Command + Option + Shift + Click Mask Thumbnail
Intersect mask from selection

• Q
Toggle Quick Mask mode
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INSIDE THE COLOR RANGE MENU

• Option
Toggle the Reset button and the “Subtract from Sample” tool

• Command
Toggle between the Selection view and Image view

• Shift
Toggle the “Add to Sample” tool
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Mastering Photoshop With Paths
Tom Giannattasio

Anomalously residing within the pixel-gridded world of Photoshop are a 
series of tools waiting to break out of the canvas’ inherent squareness. 
Mastering these tools opens the stage for a higher level of flexibility, full of 
clean lines and non-destructive editing. Presented here is a guide to help 
you build proficiency, increase productivity and demystify the elusive world 
of Paths.
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Creation

PEN TOOL

The Pen tool (P) – simple to use but difficult to master. It provides a precise 
method for creating paths, but requires an experienced hand to plot 
naturally flown curves. The power unlocked by mastering this tool is well 
worth the time needed to do so. While no amount of instruction can make 
you a Bezier master, below are some tips to keep in mind as you practice.

• Always use as few points as possible.

• Place an anchor at every acute or abrupt angle.

• Mid-curve anchors should be placed to comfortably accommodate 
curve transitions.

• To help set anchor points, you can turn on the ‘Rubber Band’ option – 
located in the drop-down next to the Custom Shape Tool button in the 
Pen’s property bar. This setting will allow you to see the curve 
connecting the last anchor point with the mouse’s current position.
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Pen Tool with the Rubber Band setting
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SHAPE TOOL

The Shape Tool (U) gives you access to standard geometric shapes as well 
as more complex presets with the Custom Shape setting. To define your 
own custom shape, select the shape using the Path Selection Tool (A), right-
click inside the canvas, select ‘Define Custom Shape…’, name it and click 
OK. When using the Shape tool, more advanced settings – involving size, 
proportion, origin and pixel-snapping – lie hidden inside the drop-down next 
to the custom shape button in the tool’s property bar.

Advanced Shape Tool settings
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FROM TYPE

Converting type to a shape layer allows you to work directly with the 
anchors and curves of each letter and might even help improve your 
typesetting. This technique is most useful when you know the text won’t 
change as you’ll have to sacrifice the ability to edit it. With the type layer 
selected, right-click the layer in the Layers palette and choose ‘Convert Type 
to Shape’. You now have access to the actual paths used to create the type. 
Thinking of type in this manner – as shapes instead of letters – can 
dramatically change the way you work. Kerning is now more intuitive; select 
a letter and move it – no pesky integers to set!

Type to Path conversion

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 79



FROM SELECTIONS

The editing of paths is far superior to raster data, especially when it comes 
to matters of upscaling. If working with a simple enough raster shape, why 
not convert it to a path? Select your shape. From the flyout menu in the 
Paths palette, select ‘Make Work Path…’ or Option-click the ‘Make work path 
from selection’ button at the bottom of the palette. Set the tolerance based 
on the complexity of your shape – the simpler the shape, the higher the 
tolerance. Click OK. You’ll notice that pixel to path conversion is not an 
exact science, but with some manual clean-up you can effectively recreate 
the original shape.

Selection to Path conversion
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Implementation

MODES

When creating paths via the Pen or Shape tool, three settings – found in the 
tool’s property bar – are available to define how the path should be used: 
Shape Layer, Paths and Fill Pixels. The Shape Layer setting will automatically 
create a new fill layer using the color and layer style set to the right. Paths 
will create a temporary Work Path accessible in the Paths palette, which 
makes it available for many different implementations (see below). Fill Pixels 
will paint raster data on the current layer, leaving no paths behind.

Pen tool set to create a Shape Layer
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SHAPE LAYER

A Shape Layer is essentially a Fill layer with a vector mask. They can be 
created as a solid color, gradient, or pattern, though only the foremost is 
explicitly available. The easiest way to create a Shape Layer is to use a path 
drawing tool set to Shape Layer. However, using the tool set to Paths, allows 
you to specify the type of fill used. First, draw your path. Then, click the 
‘Create new fill or adjustment layer’ in the Layer’s palette and choose from 
Solid…, Gradient…, or Pattern…. Note that you can also create an adjustment 
layer with a Vector Mask in the same manner.

Creating a Gradient Shape Layer
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VECTOR MASK

Vector Masks are often more preferable than a Raster Mask as they can be 
easily tweaked or scaled and still produce a crisp edge. With CS4′s 
introduction of the Masks palette, Vector Masks are more powerful than 
ever. Now, you can also feather the edges and adjust the density of a Vector 
Mask. The quickest way to create a Vector Mask is to select the layer you 
wish to mask. Then, select the path using the Path Selection Tool (A) and 
Command-click the ‘Add Layer Mask’ button at the bottom of the Layer’s 
palette.

Command-clicking to quickly create a Vector Mask
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TYPE PATHS: IN AND ON

There are two ways paths can be used with the type tool: by defining the 
baseline and by creating a custom text box shape. Select the Work Path 
you’d like to use and with the Type tool (T) mouse-over the path. The dotted 
square on the cursor will change from a square to a curved line. Click on the 
path and you’ll see that the type flows right along the path. After committing 
the type (Command + Enter), you can use the Path Selection Tool (A) to 
move the beginning and end points – indicated with an ‘x’ and a black circle 
respectively – or to flip the type from the top of the line to the bottom. If 
using a closed path, you can click inside of it to create a custom-shaped text 
box.

Type on a path
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Type in a path
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FILL AND STROKE

The Paths palette provides an interesting array of options to fill and stroke a 
Work Path. These options are available only when the current layer is a 
raster layer; you can quickly create a new raster layer using Command + 
Option + Shift + N. Then, by Option + clicking on either the ‘Fill path with 
foreground color’ or ‘Stroke path with brush’ button, you can open the Fill or 
Stroke dialog boxes. From here you can set the fill type, blending modes, 
transparency, feathering or stroke tool, which will adopt that tool’s current 
settings.

Fill Path dialog box
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Stroke tools
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Boolean Operators

USE

To allow for more complex shapes, multiple paths can be grouped together 
into a compound path, on which  Boolean operations can be set. These are 
accessible in the properties bar of the Path Selection Tool (A) and include: 
Add (+), Subtract (-), Intersect and Exclude. Add specifies a fill area and 
Subtract defines an area that is not filled; if only one path exists, the entire 
canvas is considered the fill area from which the shape is subtracted. 
Intersect sets the fill to areas included in all paths, while Exclude fills all path 
areas except those that overlap; these modes work only in compound paths.

Boolean Modes
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STACKING ORDER

When creating compound paths, it’s important to take note of the paths’ 
positions in the stacking order.  A compound shape with an Add path on the 
bottom and a Subtract on top will be completely different with swapped 
depths. A path’s Boolean operator takes effect on all of the paths below it. 
Unfortunately, there are no commands or palettes to simply swap depths in 
Photoshop; you’ll need to use a series of Cut (Command + X) and Paste 
(Command + V) to rearrange them.

Path Stacking Order
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COMBINING

Combining paths can help reduce complexity by creating a single path from 
the perimeter of a compound path’s fill area. To do so, select the paths to 
combine using the Path Selection Tool(A) and click the Combine button in 
the Tool Properties bar.

Reducing complexity by combining Paths
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Importing/Exporting

IMPORTING

Though Photoshop provides vector tools sufficient for many basic tasks, it in 
no way compares to the ease and power of Illustrator. Fortunately, Adobe 
products work in unison. You can create your paths in Illustrator and easily 
import them by Copying (Command + C) and Pasting (Command + V) in 
Photoshop. In the Paste dialog box, select either ‘Path’ to import a Work 
Path or ‘Shape Layer’ to create a fill layer with the foreground color.

Path Paste dialog box
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EXPORTING

In the occasion that you might need to translate your paths in the opposite 
direction, copy and paste will work in the same fashion as above or you can 
use Export → ‘Paths to Illustrator…’ to create a new Illustrator document with 
the same dimensions and positions as the current Photoshop document.

Paths to Illustrator…

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 92



Pixel Precision
The positions of anchor points and the lines connecting them do not 
correspond to the pixel grid of the image. This can lead to undesirable anti-
aliasing, most noticeable along horizontal and vertical edges. To avoid these 
unclean edges, you can zoom in (Command + ‘+’) and use the Direct 
Selection Tool (A) to select and move the anchor points so that they lie on 
exact pixel coordinates; Pixel Grid (Show → Pixel Grid) can be very handy 
when doing this.

On- and Off-Pixel edge comparison
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Keyboard Shortcuts

PEN TOOL (P)

• Shift + P – toggle between Pen Tool and Freeform Pen Tool

• Shift – constrains to 45° angles

• Option – change to Convert to Point Tool, used to set directional 
handles

• Command – change to Direct Selection Tool, used to move anchor 
points or stretch line segments

• Command + Shift – select multiple anchor points and segments

• Command + Option – change to Group Selection Tool, used to select 
entire paths

• Command + Option + Shift – select multiple paths

• + – set Boolean mode to Add

• - – set Boolean mode to Subtract

SHAPE TOOL (U)

• Shift + U – rotate through Shape tools

• Shift – constrain proportions

• Option (while dragging) – draw from center of shape

• Option (before clicking, if set to create Shape Layers) – temporarily 
switch to Eyedropper tool
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• Option (before and while dragging, if set to create Paths) – set 
Boolean mode to Subtract

• Option + Shift (before and while dragging, if set to create Paths) – set 
Boolean mode to Intersect

• Command – change to Path Selection Tool, used to select and move 
paths

• Command + Shift – select multiple paths

• + – set Boolean mode to Add

• - – set Boolean mode to Subtract

• Spacebar (while dragging) – move the shape’s origin

PATH SELECTION TOOL (A)

• Shift + A or Command-click inside document window – toggle 
between Path Selection Tool and Direct Selection Tool

• Shift + Click – select multiple

• Shift + Drag – move and snap to 45° angles

• Command + Option – Convert to Shape Tool

• Command + Option + Shift – Convert to Shape Tool (constrained to 45° 
angles)

• Option – change to Group Selection Tool

• Option-Click-Drag – Duplicate selected path

• Arrow key – Nudge selected path or anchor point 1px

• Shift + Arrow key – Nudge selected path or anchor point 10px
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• Option + Arrow key – Duplicate selected path or anchor point and 
move copy 1px

• Option + Shift + Arrow key – Duplicate selected path or anchor point 
and move copy 10px

TARGET PATH

• Enter – Dismiss Target Path

• Command + Enter – Selection from target path

• Command + Option + Enter – subtract path area from current selection

• Command + Option + Shift + Enter – intersect path area from current 
selection

• Command + T – Free Transform Path

• Command + Shift + T – Free Transform Path Again

• Command + C – Copy path or anchor point with neighboring points

• Command + X – Cut path or anchor point with
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#e Ails Of Typographic Anti-Aliasing
Tom Giannattasio

As printed typography enjoys the fruits of high-DPI glory, proudly displaying 
its beautiful curves and subtleties, its on-screen counterpart remains stifled 
by bulky pixels, living in a world of jagged edges, distorted letterforms and 
trimmed serifs. Until display manufacturers produce affordable 200 or 300 
PPI monitors, we’ll have to rely on software advances to fix these problems.
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Enter anti-aliasing: the next best thing to a world of higher-resolution 
monitors. The concept of anti-aliasing is fairly simple: add semi-transparent 
pixels along the edges of letterforms to smooth the appearance of the “stair-
step” effect.

However, many factors and technologies determine the actual effectiveness 
of the process: hinting, subpixel rendering, software capabilities and 
operating system specifications, to name a few. Here, we’ll look at what you 
as a designer can do to improve the results of anti-aliasing with Photoshop, 
Flash and CSS. Plus, we’ll explain the constraints of hardware, browsers and 
operating systems.

Technologies

ALIASED VS. ANTI-ALIASED

It takes only a quick glance to realize that anti-aliasing is extremely 
important to making text legible. With few exceptions, anti-aliased text can 
dramatically reduce eye strain, not to mention that it renders glyphs much 
closer to their intended design. Because of this, designers must decide 
how, not if, anti-aliasing should be used. This decision is based on a 
number of factors that one has to consider in the process from design to 
delivery.
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42pt “Goudy Oldstyle Bold”: aliased and anti-aliased versions
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FONT HINTING

Most text rendering engines rely heavily on hinting to determine exactly 
which areas of a glyph should be smoothed. Font hinting, or instructing, 
uses tables of mathematical instructions to align letterforms to the pixel 
grid and to determine which pixels should be grayscaled. Though most 
software provides auto-hinting using standardized algorithms, ideally the 
process would be done manually by the type designer and embedded in the 
file.

Put simply, these instructions work by modifying the position of structurally 
important points, such as those found along splines or at the base of stems, 
and aligning them at pixel boundaries. Intermediate points are then 
repositioned based on their relationship to the primary points. Using an 
open-source font editor, such as FontForge, allows you to view and edit a 
font’s hinting information. See how much work goes into producing a clear 
glyph; your appreciation of type designers and font engineers will certainly 
increase.
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Hinted and unhinted type both have their pros and cons, leaving the designer to 
choose between legibility and typeface integrity.
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Viewing the hints for Goudy Oldstyle’s “H” using FontForge.
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SUBPIXEL RENDERING

Every pixel on a standard monitor consists of three components: a red, a 
green and a blue. The brightness of each of these sub-pixels is controlled 
independently, and because of their small size, our eyes blend the three into 
one solid-colored pixel. Typical anti-aliasing sets even values for each of 
these subpixels, resulting in full grayscale pixels. Subpixel rendering 
exploits the individuality of each single-colored component and uses it to 
increase the perceived resolution of the monitor. This allows a pixel to take 
on visual weight from neighboring pixels, thereby allowing type to be 
smoothed in smaller increments. Rendering the type in this manner can 
produce subtle color shifts visible along the edges of glyphs.

Subpixel rendering relies on a perfectly aligned grid of pixels, which makes 
LCD flat panels the only type of monitor on which this technique works 
consistently. CRT monitors suffer from inaccuracies and oddly distributed 
pixels, making subpixel rendering extremely difficult to pull off. Even LCD 
monitors have variations in their subpixel arrangement that must be 
accounted for; some monitors are arranged in the order of RGB, while others 
are ordered BGR.
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Subpixel rendering triples the perceived resolution by setting each color 
component separately.
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Subpixel rendering produces more desireable results than standard rendering, 
but adopts color fringes.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 105



Input
As designers and developers, we have limited control over how type is 
ultimately seen by the end user, but by using the proper delivery method, 
we can ensure an optimized presentation. That said, we’ll look here at the 
three most common ways in which text is sent to the user: HTML, images 
and sIFR. Each of these methods has an ideal use that, when properly 
implemented, can dramatically increase legibility and thus the overall user 
experience.

HTML TEXT

HTML text undoubtedly accounts for the majority of text found on the Web. 
Until recently, designers had absolutely no control over anti-aliasing with 
client-side technologies. CSS 3 introduces two new ways to control how 
HTML text is delivered: font-smooth and @font-face.

font-smooth
Font-smooth allows you to control when smoothing is used but not how it’s 
used; the anti-aliasing method is still controlled by the user’s environment. 
This setting is not widely supported yet but may prove useful by allowing us 
to turn anti-aliasing off at small point sizes — where type often becomes 
blurry. It may become doubly useful when more complex and non-browser-
safe fonts are embedded with the new @font-face rule.
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@font-face
The @font-face rule is an exciting new feature of CSS 3 that designers have 
been waiting years for. Although we’ve been able to add obscure typefaces 
to font stacks for quite some time, a large majority of users don’t have high-
end fonts on their local machines and end up with a typical Web-safe font 
(e.g. Times New Roman substituted for Adobe Garamond Pro). By allowing 
the browser to import a font file from a URL, we can now serve the user any 
font we’d like without relying on their font library. This means that we can 
serve not only more unique fonts but also those that are better hinted and 
more legible.

Despite the promise this feature holds to create a more beautiful world of 
online typography, we may still see designers opt for fonts like Verdana, 
which have been designed and hinted specifically for on-screen viewing. 
Some of our favorite fonts from the print world just look bad when rendered 
on the screen, especially at smaller text sizes. Surely we’ll see new industry 
segments arise as a result of the support of @font-face, including an influx of 
browser-hinted typefaces made available through services such as typekit.

Bickham Script Pro embedded using @font-face and rendered in Safari 4 and 
Firefox 3. Notice the OpenType swashes and ligatures supported in Firefox 3!
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TEXT AS IMAGE

Serving text as an image may have limited uses, but it allows you to fine-
tune every letter if necessary. Photoshop provides five pre-set anti-alias 
settings, which determine pixel values using different algorithms in 
conjunction with the document’s pixel grid. Unfortunately, none of these 
settings allow for subpixel rendering, but by using the Free Transform 
option to nudge the layer’s position, you can effectively force the 
algorithms into rendering cleaner. Each setting allows a different amount of 
origins, and some only produce variations when translated along the x-axis. 
Below is a table of available transformations.
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None

Aliased text, created using the None setting, has a very limited use and 
typically looks best between point sizes of 9 and 18. Sizes lower than this 
range will result in unidentifiable characters, and larger sizes will lead to 
increased character weight and overly jagged edges. Depending on the 
font, sometimes two different point sizes will render at the same height, 
causing a shift in letter spacing, width and x-height. For example, 14pt Arial 
renders 10 pixels high with an x-height of 8 pixels. Arial at 13pts also sits 10 
pixels high but has an x-height of only 7 pixels — a slight but very 
perceivable difference. When tightly tracked, this setting may also require 
manual kerning, because some letters will sit pixel to pixel against each 
other.

13pt and 14pt Arial render with the same cap height but different x-heights.
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Sharp

The Sharp setting uses very tight grid-fitting and produces sharp, if not too 
sharp, type. The plotting of pixels with this setting is very similar to how the 
None setting plots them but allows for a certain degree of smoothing. In fact, 
if pixels are set atop one another, you can actually see that a majority of 
solid pixels carry over from None to Sharp. While the cap height and x-
height typically remain the same, you might see an increase in character 
weight and width. Sharp has a tendency to completely cut subtle shape 
variations from rendering and sometimes causes inconsistent letterforms, 
so if typeface integrity is important to you, you may want to try a different 
setting.

Crisp

The Crisp setting maintains much of the font’s original weight and curvature 
but cleans up some of the awkward pixels created by light serifs and thin 
strokes — which is especially useful for larger point sizes. With the Crisp 
setting, however, you sacrifice the ability to nudge the layer on the y-axis.
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Strong

The Strong setting is notorious for adding unnecessary weight to a typeface, 
but it provides the most freedom with translating the origin, with 32 x-axis 
variations and 16 on the y-axis. The variety of origins with this setting can 
come in very handy when working with complex letterforms. Strong may 
also be useful when working with a typeface that has very thin strokes.

Subtle animation showing the 32 anti-aliasing origins at 36pt, 18pt and 12pt.
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Smooth

The Smooth setting is the closest to unhinted anti-aliasing and therefore 
remains truest to the original glyph shape. This algorithm is best used on 
medium-sized to large type, because it tends to render very light and often 
blurry at smaller point sizes. If used with an appropriate typeface at a proper 
size and if the origin is properly adjusted, this setting can produce a 
beautiful balance between crispness and letterform fidelity.

Shape Layer
If Photoshop’s hinted algorithms all produce undesirable results, you may 
want to attempt using unhinted anti-aliasing by way of converting the type to 
a shape layer. This allows you access to the original outlines of the font, 
which draw values based on the percentage of the pixel enclosed in the 
shape. What you sacrifice in editable type, you make up for in origin 
transformations: 32 on both the x- and y-axes. Though usually a last resort, 
don’t rule out the possibility of using a Shape Layer; it can often produce 
much better results than Photoshop’s algorithms.

Fractional Widths
Another, more veiled, setting that sometimes helps with anti-aliasing type at 
small point sizes is the Fractional Widths option located in the Character 
palette’s fly-out menu. With this setting turned on, the character spacing is 
set to varying fractions of pixels. This is ideal for auto-kerned type at large 
sizes but tends to bump the type either too close together or too far apart at 
smaller sizes. Turning this option off will round all character spacing to 
whole pixel values, which may help better space the problematic type. This 
is a hit-or-miss option, so use it wisely.
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Decimal Point Sizes
Typophiles might cringe at the idea of using a decimal point size, but when 
designing for digital media, standard point sizes don’t always conform to the 
pixel grid. By using decimal point sizes and either the Smooth or Strong anti-
alias setting, you can usually bring a blurry typeface back into focus. Please 
note that I am not condoning the use of vertical or horizontal scale!

Using decimal values can dramatically improve anti-aliasing results, as seen 
above. Top: 16pt Goudy Oldstyle with Strong Anti-Aliasing. Bottom: 16.5pt Goudy 
Oldstyle with Strong Anti-Aliasing.
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SIFR TEXT

Using sIFR to replace headers with a block of Flash brings benefits beyond 
the obvious. Yes, it solves the problem of having to use CSS image 
replacement techniques to provide a wider array of fonts, but it also allows 
incredible control over how the type is anti-aliased. Particularly useful are 
the sharpness and thickness settings, which control the edges of glyphs. (If 
only Photoshop had these settings!) You can set and tweak a number of 
settings to fit your implementation; and they can be controlled by passing 
keyword arguments inside the sifr-config.js file. These settings include:

sharpness (number)

A value between -400 and 400, which determines how sharp (positive 
number) or soft (negative number) the edges of the glyphs will be.

thickness (number)

A value between -200 and 200, which sets the thickness of the glyph 
edges.

gridFitType (string)

Possible values are: “none,” “pixel” and “subpixel.” This specifies how 
prominently the horizontal and vertical lines are fit to the monitor’s pixel grid. 
“Pixel” and “subpixel” usually produce the best results.

antiAliasType (string)

This is set by default to “advanced,” which allows the anti-alias settings 
above to be applied. It can also be set to “normal,” but this option limits 
sIFR’s rendering capabilites to accommodate earlier versions of Flash Player 
and overrides any of the properties above.
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sIFR allows you to precisely customize your anti-alias settings. Notice that the 
custom setting is slightly thinner and crisper.

Output

DISPLAYS

Because very few people have monitors with resolutions higher than 100 
pixels per inch (PPI), we have to rely on software to trick our eyes into 
thinking that the resolution is greater than it really is. Some advances are 
being made by display manufacturers, but they are still beyond the average 
Web surfer’s budget.

A typical LCD monitor (which you’re probably reading this on) has a dot pitch 
of around .20 or .30 millimeters. New technologies, such as the Ferro Liquid 
Crystal display are touted to reduce that number to .012 millimeters. Bringing 
this technology to the mainstream would bring tremendous advantages to 
the world of design and on-screen reading. However, until they become 
affordable for the average consumer, we’ll be relying on software advances.
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OPERATING SYSTEM

Microsoft and Apple have both delivered technological advances in the 
world of anti-aliasing, but they have somewhat different approaches. The 
current versions of both operating systems use anti-aliasing and subpixel 
rendering. Both vendors have dramatically increased legibility within their 
operating systems, but controversy has arisen over the aesthetics and 
legibilty of each. Microsoft’s entry in the competition — which is 
characterized by tight grid-fitting — is aptly named ClearType. By forcing 
characters tightly into the pixel grid, ClearType increases contrast along the 
edges of glyphs and renders more crisply.

Distinctly different is Apple’s Quartz 2D, which puts emphasis on maintaining 
the shape and integrity of the typeface. This certainly makes sense, given 
the high proportion of designers who work on Macs. But Quartz rendered 
type often appears blurry, which can cause eye strain with extended 
reading.
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Windows Vista and Window XP both use Microsoft’s ClearType rendered 
either by Windows Presentation Foundation or Graphics Device Interface; 
both handle text in a very similar fashion, though WPF doesn’t snap 
horizontally to the pixel grid. Windows XP actually comes defaulted to 
monochromatic anti-aliasing.

But ClearType can be turned on by going to Control Panel → Appearance 
and Themes → Display, clicking on the “Appearance” tab, selecting 
“Effects…” and changing the drop-down from “Standard” to “ClearType.” The 
operating system itself allows for very little customization of ClearType; you 
basically choose between on and off. Microsoft’s ClearType Tuner 
PowerToy, though, allows some control over how it renders. Windows 7 
brings a new rendering platform, named DirectWrite, that introduces 
subpixel positioning and y-direction anti-aliasing. As seen in this 
presentation, the advances made with DirectWrite are quite impressive and 
sure to be adopted by other vendors.

Apple’s Quartz 2D now renders type using Core Text, which has recently 
replaced Apple Type Services. The Quartz 2D displays type much closer to 
the typeface’s original design, which is similar to how you might expect to 
see it in print form. While this seems like a good idea from a design 
perspective, it doesn’t hold up with legibility, at least not on common LCD 
screens. Quartz text could conceivably appear much better if we were using 
higher-resolution monitors. Because Apple has complete control over both 
the operating system and the hardware that it runs on, perhaps a 200 PPI 
iMac is just around the corner. We can hope!
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BROWSERS

The most current browsers today all inherit the anti-alias settings of the 
operating system. But with one anomaly. Firefox 3 in Mac OS X seems to 
inherit the operating system’s settings but also seems to apply more precise 
grid-fitting and kerning. Perhaps Mozilla is attempting to improve on Quartz’s 
blurry rendering.

Unfortunately, we have no way to control or even tell how the user’s 
browser will render text. What we can do is understand the nuances of each 
browser and make sure that we deliver a suitable presentation across all 
viewing platforms. Below is a list of browser capabilites and type samples to 
help you gain some insight into how they handle anti-aliasing.

Windows XP and Vista:

• IE6, IE7 and IE8:

• Firefox 2 and 3:
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• Safari 4:

• Chrome:

Mac:

• Firefox 2 in OS X:
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• Firefox 3 in OS X (inherits from operating system but with slightly 
enhanced kerning — most noticeable in the word “Georgia”):

• Safari 4 in OS X:

• Opera:
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Conclusion
Though many advances have been made in rendering on-screen 
typography, most have been aimed at treating the symptoms and not the 
disease. Until everyone has a 200 PPI monitor sitting on their desk, it will be 
up to designers and developers to use the proper technologies to ensure 
legibility without degrading the design of the typeface.
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Mastering Photoshop Techniques: Layer 
Styles
Tom Giannattasio

Layer Styles are nothing new. They’ve been used and abused again and 
again. Despite their ubiquity, or perhaps because of it, many designers do 
not yet realize the full potential of this handy menu. Its beauty lies in our 
ability to create an effect and then copy, modify, export, hide or trash it, 
without degrading the content of the layer.

Below we present, step by step, several practical techniques to help you 
refine your designs, increase productivity and reduce layer clutter.

Download the source files (.zip, 1.6 Mb).
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#e Bump Map Effect
“Wait, what?” you exclaim, “There’s no bump map effect in the Layer Styles 
menu!” That’s true, but by combining Pattern Overlay and Bevel and 
Emboss, we can achieve a textured, bump-mapped surface with a 
controllable light source.

This technique requires two images: one for texture and color, and the other 
to serve as a depth map. The depth map needn’t have any hue because it 
determines depth based on a composite value, black being the lowest, 
white the highest. In some cases, you may be able to use the same image 
for both, but in our example we’ll use completely different ones.

STEP BY STEP

1. We’ll start by creating our bump map pattern. Open the diamond-
plate.psd file.

2. Inside you’ll find a number of white shapes on a black background. 
Create a pattern from this document: Select All (Cmd/Ctrl + A), then 
“Edit” → “Define Pattern.” Name it “diamond plate bump map” and click 
okay.

Creating the diamond plate pattern.
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3. Now, open the start.psd file.

4. Repeat step 2 to create a pattern from the “patchy gray” layer. This will 
be used later to add texture to our background.

Defining the texture pattern.

5. After creating the pattern, delete the “patchy gray” layer. It’s no longer 
needed.
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6. Use the Rectangular Shape tool to create a shape layer about 20 pixels 
wider and 20 pixels higher than the canvas. Change the color of this 
layer to a dark, brownish, chromatic gray.

Creating the shape layer for our background.
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7. Be sure that the shape layer doesn’t have any Layer Styles already 
applied to it (Photoshop will often apply the most recent Layer Style 
automatically). Then, begin the new Layer Style by adding a Pattern 
Overlay.

Adding a Pattern Overlay effect.
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8. Choose the “patchy gray” pattern from the pattern picker, and 
change the Blend Mode to Soft Light. This will add the texture to our 
background layer.
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Adding a pattern overlay effect.
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9. Next, add a Bevel and Emboss, along with the Texture effect. This 
time, change the Texture effect’s Pattern to the “diamond plate bump 
map” pattern created in step 2. We now have a grungy diamond plate 
background.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 130



Applying the Bevel and Emboss texture effect.
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10.As with most Layer Style effects, the default values are rarely ideal. By 
tweaking the Bevel Type and Size, Gloss Contour, Highlights, 
Shadows and Light settings you can achieve some dramatic results.
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Tweaking the Bevel and Emboss settings.
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11. With a few extra effects, you can shape the background layer even 
more. The example has a Gradient Overlay to simulate reflected light 
by darkening certain regions of the image.
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Using the Gradient Overlay to darken some regions.
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12.You may notice that the highlights from the Bevel and Emboss filter all 
seem to have the same value. This is because the Bevel and Emboss 
effects are very high on the Layer Style’s stacking order. To darken the 
highlights that lie outside our main light source, simply paint a Layer 
Mask using the Brush tool.

Painting a mask to increase the appearance of light in the background.

We now have a textured, bump-mapped background that is completely 
dynamic; everything about it can be modified easily from within the Layer 
Styles menu. Consolidating complex imagery into one dynamic layer like this 
can reduce layer clutter dramatically and allows you (and whoever else may 
be using the file) to easily find and modify things. Now, let’s move on to 
creating our icon.
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3-D Modeling
By combining some interior effects, we can use the Layer Styles menu to 
create simulated 3-D objects: great for icons, buttons and other interface 
objects. We’ll now model the base of the round icon in the example image 
using a single layer.

STEP BY STEP

1. Begin by creating a circular shape layer with a rich red fill.

Creating the shape layer for the icon’s base.
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2. As is often the case when modeling a 3-D shape, let’s begin by adding 
a Gradient Overlay to our Layer Style. A white-to-black Radial-styled 
gradient set to Linear Burn works best for our implementation. Be sure 
the white area of the gradient is at the origin.

Adding Gradient Overlay set to Linear Burn.
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3. We now have a dramatically shaded sphere with a head-on light 
source. By decreasing the opacity of the gradient, we can flatten the 
shape to a more concave button.

Reducing the Opacity for a subtler effect.
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4. Let’s also move the direction of the light to the upper-left. While leaving 
the Layer Style menu open, move the mouse over the image itself (the 
Move Tool icon should appear). Simply click and drag the epicenter of 
the gradient to the upper-left of the shape layer.

Repositioning the gradient within the Layer Styles menu.
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5. While Bevel and Emboss may seem like more logical tools, you can 
often get a cleaner, more customizable beveled look by using a 
combination of other effects. First, add a black Inner Glow, set to 
Multiply. Adjust the Choke, Size, Opacity and Contour until you have a 
softened edge inside the shape.
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Adding a Glow to darken the edge of the base.
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6. Like for any well-rendered spherical surface, we have to add some 
reflected light in our shadow region. This is easily achieved with the 
Inner Shadow effect. Change the color to white and the Blend Mode to 
Linear Dodge. Adjust the angle so that it appears in the lower-right of 
our shape. Tweak the Contour, Distance, Size and Opacity to create a 
subtler effect.
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Adding subtle reflected light using Inner Shadow.
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7. To enhance the feeling that the shape is part of the document’s 
“environment,” we can add some effects to interact with the 
background. Drop Shadow is usually the easiest tool to use for this. 
Massage the settings until everything feels right.
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A simple Drop Shadow goes a long way.
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8. Using the Outer Glow effect, we can simulate the reflected red light 
that our background image would absorb if this were an actual setting. 
Change the glow’s color to a darker red, and change the Blend Mode 
to darken. Again, work with the Size and Opacity settings to create the 
desired effect. This is one of those effects that, when used correctly, no 
one should notice because it just looks natural.
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A red Glow to add more “environment.”

Please notice that Layer Style gradients can’t be dithered, which can make 
them lower quality than their Gradient Layer and Gradient Tool counterparts 
(— Marc Edwards).
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Diffuse vs. Specular Light
Now, our icon reflects a simulated diffuse light, which gives it the look of a 
matte-finished surface. If you prefer a glossier appearance, you can easily 
create a specular highlight using (what else?) Layer Styles.

STEP BY STEP

1. Duplicate the current shape layer (Cmd/Ctrl + J).

2. Clear the new layer’s Layer Styles: right-click the layer in the Layers 
palette and select “Clear Layer Style.”
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3. We also need to modify the shape of the layer to give the reflected light 
a sharper edge. Using the Direct Selection Tool (A), select the shape 
path in the layer’s vector mask. Copy it (Cmd/Ctrl + C) and paste it 
(Cmd/Ctrl + V) above the current path. Change this path’s mode to 
Subtract from shape area (-). Then move the shape down and to the 
right to create a crescent shape. You may also want to make the 
negative shape larger to create a more natural inside curve: simply 
Free Transform (Cmd/Ctrl + T) and then scale the shape up.

Modifying the shape of the specular highlight.
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4. Because we need this layer only for its Layer Styles, we can set its Fill 
Opacity to 0%. 

Dropping the layer’s fill to 0%.
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5. We also want this layer to inherit the Layer Styles of the underlying 
layer, so create a Clipping Mask on the new layer (Cmd/Ctrl + 
Option + G).

 
Creating a Clipping Mask to inherit effects.
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6. Now, begin the Layer Style with a Gradient Overlay. Use the default 
black-to-white gradient, and set the Blend Mode to Screen. Knock the 
Opacity down to about 50%, and change the angle to about 115°. You 
may need to change the positioning of the gradient, which you can do 
by clicking and dragging inside the document window, just as you did 
in the 3-D modeling section.
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Setting the Gradient Overlay to Screen.
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7. This is a good start for the highlight, but it still looks somewhat 
unnatural. Using a transparent inside stroke, we can shrink the 
perimeter of the interior effects. Add a Stroke effect to the layer and 
drop its opacity to 0%. Change the position to Inside, and work with 
the size slider until the highlight begins about where the darker inner 
glow ends on the underlying layer (the example image uses 5 pixels).
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Using a 0% Inside Stroke to shrink the perimeter of interior effects.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 156



8. To add a more dynamic look to your highlight, you can add a white 
Inner Shadow set to Screen with a custom contour. Tweak the 
distance and size settings to finish off the effect.
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The Inner Shadow creates a more dynamic specular reflection.
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X-Ray Vision

STEP BY STEP

To create the die-cut type inside our icon, we could turn the text layer into a 
shape layer and use the paths to mask away areas from the base. However, 
this would result in degenerated content; we would no longer be able to 
modify the type. Instead, we’ll simulate a mask using the Knockout Blending 
Option. This will also allow us to apply custom effects to the cut-out area.

1. Create a new Type Layer with the text “fx”, and position it within the 
circular base. The example uses 120 point Garamond Bold Italic.

2. Drop the Fill Opacity to 100%.
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3. Begin your Layer Style by adding an Inner Shadow. Increase the size, 
and increase the opacity to about 90%. You may also want to modify 
the distance and contour to your liking.

The beginnings of the die-cut effect.
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4. We now have the beginnings of a die-cut effect, except that the text still 
shows the base below it. To fix this, go to the Blending Options 
section in the Layer Styles menu. Change the Knockout from None to 
Shallow (this setting samples pixels from the layer directly beneath the 
current layer’s group). Because our text layer doesn’t belong to a layer 
group, it samples instead from the Background layer. (Using a Deep 
Knockout would always sample from the Background layer, regardless 
of the layer’s group.)
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Shallow Knockout samples pixels from the layer directly beneath the current 
layer’s group.
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5. To get the text layer to sample from our diamond plate layer, start by 
clicking “Okay” to close the Layer Style menu. Select the text layer and 
both of the buttons that make up the base, and group the layers (Cmd/
Ctrl + G). As you can see, the “fx” shapes are now drawing pixels 
from the textured layer directly below the new layer group.

Grouping the icon so that the Knockout samples from the diamond plate layer.
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6. The knockout effect is very convincing, but the type still feels detached 
from the base. Let’s add a beveled effect to simulate the surface quality 
of the base. Start by adding an outside Stroke with a size of 2; then 
drop the opacity to 0%. This doesn’t achieve anything but is necessary 
for the next step.

7. Now add a Bevel and Emboss effect. Change the Style to Stroke 
Emboss and Technique to Chisel Hard. This will apply the bevel’s 
lighting effects within the stroke area created in the step above. Modify 
the settings to achieve a subtle and smooth edge.
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Adding a Stroke Emboss.
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8. Let’s take the bevel one step further by adding a thin specular highlight 
to the bottom-right edges of the shape. We can use a white Drop 
Shadow effect, set to Screen, to add a bright highlight just at the edge 
of the bevel. You’ll want to modify the distance and size to give the 
highlight a sharp edge. 
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Adding a thin specular highlight using a Drop Shadow.
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9. Finish off the Layer Style with more shading within the die-cut letters by 
adding a simple black-to-white Gradient Overlay, set to Multiply.

Finishing off the die-cut.
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Quick Tips
Despite frequent misuse, the Layer Styles menu really is a powerful tool that 
every designer should learn to work with. Not only does it provide a level of 
speed and control not easily found through other means, but it provides 
invaluable flexibility. Our example shows how a multi-dimensional icon and a 
completely dynamic background can be consolidated within four simple 
Shape layers, allowing them to be easily modified, reused and repurposed 
throughout your designs. Below are a few extra tips to remember when 
working on your next project.

EFFECTS STACKING ORDER

You may have noticed sometimes that an effect isn’t visible when another 
effect is being used. For example, a Color Overlay seems to override a 
Gradient Overlay. This is because of the Layer Styles Stacking Order. Just as 
with the Layer’s Palette, one layer will cover another that is lower down in 
the stacking order. Unfortunately, the Layer Styles menu doesn’t allow you 
to rearrange the order of effects. One way around this (even if you sacrifice 
the ability to edit) is to use Create Layers, which turns all of your Layer Style 
effects into actual layers that you can move.

Interior Effects Stacking Order:

• Stroke

• Bevel and Emboss

• Inner Shadow

• Innger Glow

• Satin

• Color Overlay
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• Gradient Overlay

• Pattern Overlay

Exterior Effects Stacking Order:

• Stroke

• Outer Glow

• Drop Shadow

NON-COLOR-SPECIFIC STYLES

Though not always possible, you may want to use black, white and grays for 
your effects. Using monochromatic colors in conjunction with the proper 
Blend Mode allows you to create styles that are non-color-specific, meaning 
you can modify the color of the actual layer, and your Layer Style will update 
appropriately.

SCALING EFFECTS

There may be times when you’ve created a Layer Style that looks great at 
the original size, but when the shape is increased or decreased, your 
beautiful style is destroyed. Fortunately, Photoshop provides a method to 
adjust styles that are out of whack. Simply choose Layer → Layer Style → 
Scale Effects, and then input the percentage you need.
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INCONSPICUOUS MENU OPTIONS

A number of hidden commands are available to you from within the Layer 
Styles menu. Depending on the effect, you will have access to either the 
Hand tool or the Move tool by simply mousing over the document window. 
The Hand tool allows you to move the document around just as you would 
outside the Layer Styles menu, and the Move tool repositions the current 
effect and updates the settings automatically. When using the Move tool, 
you can still access the Hand tool by holding the space bar. While using 
either of the tools, you can zoom in and out by holding Space + Cmd or 
Space + Option respectively. Don’t forget, as with most other menus in 
Photoshop, holding “Option” will change the “Cancel” button to a “Reset” 
button, allowing you to undo any changes.
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Establishing Your Grid In Photoshop
Steve Schoeffel

Creating a grid is typically one of the very first things you do when starting a 
design comp. After all, it provides the basic structure on which the rest of 
your design will lie. In this article, we’ll provide two different methods for 
efficiently establishing a grid. These methods enable you to quickly and 
smartly form a grid so that you can spend more time designing.
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Method 1
The first method uses GuideGuide by Cameron McEfee to set up vertical 
columns. This Photoshop plugin is said to be in beta, but from my 
experience with it everything works perfectly well, and there is even talk of 
the release of GuideGuide 2, which will include more features. Instructions 
on installing it can be found on the GuideGuide page. There is also a video 
tutorial on using it that was put together by Russell Brown at Adobe.
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SET UP YOUR GRID IN 5 SECONDS

1. Determine the margins, number of columns and gutter widths. Then 
click “Create Guides.”

2. If the canvas for your design comp is wide, do the quick math so that 
the margin lengths allow for the grid to be constrained to your 960 
pixels. For example, if the canvas is 1200 pixels wide, then the left and 
right margins would be 120 pixels each.

An example of 12 columns with 20-pixel gutters and margins set to 120 pixels.
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You can also set a baseline grid this way, but you’d end up with a lot of 
guides. A better option might be the method featured on a Method & Craft 
video by Mike Precious…

METHOD & CRAFT’S EXTENSIBLE BASELINE GRID

Here is a brief summary of the steps for setting up an extensible baseline 
grid.

1. Establish the grid’s baseline value, then create your pattern template. 
The baseline grid is determined by the leading (or line height) of the 
body text. For example, if the main body copy of your design is set in 
13-point Helvetica, with the leading at 18 points, then you would set up 
an 18-pixel baseline grid.

2. Create a Photoshop file that is the height of your baseline grid, fill the 
bottom pixel, and leave the remaining pixels transparent. In this case, 
the dimensions of your canvas would be 1-pixel wide and 18-pixels tall.
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3. “Select All,” and then save this as a new pattern. You can do this by 
going to Edit → Define Pattern…
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4. Go to Adjustment Layer → Pattern, and select your newly created grid 
pattern.
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5. Adjust the opacity as desired.

An example of method 1 with the columns and baseline grid together.

ADVANTAGES

• You get an optional baseline grid, which you can use independent of 
the vertical column grid. A baseline grid can create visual clutter when 
laid over top a design comp. With this method, it can just be toggled on 
when needed.

• If you prefer to use guides for your grid, this is the better solution.

• You can hide and show the grid through an easy shortcut.
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DRAWBACKS

• Using vertical guides to mark other elements in the document can be 
difficult because you might confuse them with the grid.

• Compared to method 2, your options for the grid are not as specific or 
comprehensive (such as setting the height of the horizontal module).

• Grid lines are determined mathematically and won’t necessarily align 
with the pixel grid. This means that your guides could in some cases fall 
unevenly and end up being positioned down the middle of the actual 
pixels.

• This method requires two separate processes to create a vertical and 
baseline grid, compared to just the one method coming up.
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Method 2
Modular Grid Pattern is an all-in-one grid solution. The tool creates a vertical 
columnar grid and a baseline grid all as one pattern. There are two ways to 
go about using Modular Grid Pattern:

Application Panel
In addition to Photoshop, this also works with Fireworks, GIMP and Microsoft 
Expression Design. Please note that you must have the latest software 
(Adobe CS5 or the equivalent of one of the other applications) and an 
Internet connection for this panel to work. That being said, if you have 
already created a pattern and saved it in your library, then you would be 
able to access it without needing anything else.
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Web app
This works in Chrome, Firefox, Safari and Opera. The Web app enables you 
to create a grid pattern and download it straight from the browser in all 
formats.

Whichever way you choose, just pick a module width, gutter width and 
baseline number, and Modular Grid Pattern does the rest. You can also 
specify a height for the horizontal module.

ADVANTAGES

• This is a fast way to get it all; an all-in-one layer.

• You have the option to download a Photoshop pattern file, PNG or 
transparency mask.

• You can label the patterns and put them in a folder so that you can 
come back to the grid with virtually no set-up required at all.
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• Frees your guide to be used for other purposes.

• You can specify a height for the vertical module to establish an overall 
vertical rhythm.

• The grid can be overlaid with varying degrees of opacity, so you can 
make it less distracting as you are designing.

• Supports applications other than Photoshop.

DRAWBACKS

• If your canvas is wide, then making the grid a pattern will make it extend 
across the entire page, which could be annoying and make it harder to 
see the boundaries of the content. This can be fixed in a couple of 
ways:

1. Apply a layer mask to constrain the grid to just the main content 
area.

2. Draw a rectangle the size of the main content area (for example, 
960 × 1200 pixels), and apply the grid as a layer style, with the fill 
set to 0% in this case.

• This method forces you to choose a baseline grid, preventing you from 
just creating vertical columnar modules.

• It requires you to manually hide and show the grid layer, without the 
benefit of a keyboard shortcut.
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Concluding #oughts
We hope these methods will increase your efficiency and precision in 
establishing a grid. In the end, the way you set up the grid will depend on 
your workflow. Evaluate your needs, then choose the method best suited to 
them. Either method requires minimal set-up but can save much time and 
frustration.

ADDITIONAL RESOURCES

If neither method interests you, quite a few templates out there would also 
do the job. I recommend checking out Mindy Wagner’s layout template and 
Robbie Manson’s 960-pixel grid templates. Also, The Grid System links to a 
number of quality resources and tools.
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Pixel Perfection When Rotating, Pasting 
And Nudging In Photoshop
Marc Edwards

When creating Web and app interfaces, most designers slave over every 
single pixel, making sure it’s got exactly the right color, texture and position. 
If you’re not careful, though, some common functions like moving, rotating 
and pasting can undo your hard work, resulting in a blurry mess. But with 
some small changes to your workflow, you should be able to maintain the 
highest-quality artwork from the start to the end of the project.

Pixel-Perfect Rotation
If you’re not careful, rotating layers in Photoshop can damage them in a very 
noticeable, pixel-mashing way.

When rotating layers with Free Transform (and some other tools) to exactly 
90 or 270°, the quality of the outcome is determined by the layer’s size. If 
the layer is of an even width and even height, then you’ll be fine. If it’s of an 
odd width and odd height, you’ll also be okay. But if they’re of an odd width 
by even height or even width by odd height, then you’ll see something like 
the result below:
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In this case, the artwork is 20 × 9 pixels: even-by-odd dimensions. The 
results for bitmap layers and vector layers are different, but they both 
produce unusable results because the origin of rotation doesn’t fall on an 
exact pixel boundary.

A FIX

Because even-by-odd or odd-by-even dimensions are the problem, we need 
a way to ensure that the contents of the layer are odd-by-odd or even-by-
even. Probably any method you can think of will solve this problem, be it 
adding a square bitmap mask to a layer or adding more content to the layer 
that you’re rotating. You could also draw a square on another layer and 
rotate both at once.

As long as the dimensions for the layer or layers are even-by-even or odd-
by-odd, it’ll be fine.
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AN EASIER FIX

Changing the origin of rotation to the top left (or any other corner) will 
ensure it is on a pixel boundary, guaranteeing perfect results every time. To 
do this, click on a corner origin after selecting the Free Transform tool, but 
before rotating. This works brilliantly and is the simplest solution yet.

Bitmap and vector masks are affected by this issue as well, so please take 
care. But the issue affects only rotated layers, either via “Free Transform” or 
“Transform” under the Edit menu. Rotating the entire canvas via Image → 
Image Rotation has no problem.

To make things even easier, I’ve created some Photoshop Actions and 
Workflows that take care of everything for you.
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Pixel-Perfect Vector Pasting
If you’ve drawn pixel-snapped artwork in Illustrator and pasted it into 
Photoshop as a shape layer, you may have noticed that the result is not 
quite what you expect (i.e. a perfectly sharp image), but rather a blurry mess. 
Here’s how to fix that.

Below is some artwork as it appears in Illustrator: perfectly formed, snapped 
to the pixel grid, and at the size we intend to use it in Photoshop.
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Below are the same paths pasted into Photoshop a few times. Notice how 
only the top-left version is sharp, while the others are half a pixel out on the 
x axis, y axis or both.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 189



WHAT WENT WRONG?

Photoshop’s pasting behavior works in one of two ways. If you’ve made a 
selection, then the clipboard’s contents are pasted so that the center of the 
clipboard is aligned with the center of the selection. If a selection hasn’t 
been made, then the contents are pasted so that the center of the clipboard 
aligns with the center of your current view. The level you’re zoomed into and 
the portion of the document you’re viewing determines the result.

A FIX

Our test artwork is 32 pixels wide by 12 pixels high. Drawing a 32 × 12 
marquee selection in Photoshop forces the artwork to land exactly where 
we want it and to be pixel-aligned. This works every single time.

AN EASIER FIX

The marquee doesn’t have to be the exact size of your artwork, though. In 
our case, a 2 × 2-pixel selection would work just as well, because the center 
of an even-width-and-height marquee selection and the center of even-
width-and-height clipboard contents would fall exactly on a pixel boundary, 
which is what we want. If the artwork was an odd width and height, then a 1 
× 1 selection would have been required.
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If you couldn’t be bothered noting your artwork’s dimensions, then by 
drawing an appropriately sized marquee, you can draw a 2 × 2-pixel 
selection and paste. If the image is blurry on the x axis only, make the 
selection 1 × 2 and paste again. If the image is blurry on the y axis only, 
make the selection 2 × 1 and paste again. If the image is blurry on both axes, 
make the selection 1 × 1 and paste again.

It may sound complex, but in practice it’s very quick; you’ll only ever have to 
paste twice to get sharp vector paths from Illustrator.

SMART OBJECTS

Pasting elements as smart objects doesn’t come with the same issue (at 
least not in Photoshop CS5 anyway). I like to use Shape layers, though: they 
allow more control and editability and have better anti-aliasing.

Pixel-Perfect Vector Nudging
When nudging vector points, Photoshop exhibits some strange behavior, 
related to how far you’re zoomed in. At 100%, nudging with the arrow keys 
will move your vector point exactly 1 pixel. At 200%, nudging moves the 
point by half a pixel. At 300%, it moves by a third of a pixel.

The behavior seems intentional, but it’s not usually what I’m after. Most of 
the time, I want to nudge in whole pixel increments. Here’s how you can do 
that, without zooming out to 100%.

Open your document, and then create a second window by going to 
Window → Arrange → New Window. You can then resize the new window 
and place it out of the way.
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Large view

Edit in the other window as normal, zooming in as far as you’d like. You’ll 
now be able to press Command + ` to switch back to the window that’s 
zoomed to 100%, nudge using the arrow keys, and then press Command + ` 
to switch back again. Because the other window is zoomed to 100%, 
nudging will move the selected vector points exactly 1 pixel.
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Large view
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Please note that holding Shift while using the arrow keys to nudge always 
moves by 10 pixels, no matter how far in you’re zoomed. Also, dragging 
points with the mouse will snap to pixels in most situations — most, but not 
all.

While not perfect, this technique does remove some of the frustration with 
editing detailed vector paths in Photoshop. Or maybe it’s just another 
reason why complex shapes should be drawn in Illustrator first, and then 
pasted as shape layers?

Take Charge Of Your Pixels
Using the correct techniques, it should be easy to place pixels exactly where 
you want. Remember, you’re the one in charge. Demand that they fall in line. 
Accept nothing less than pixel perfection.

Would you like to know more about a particular technique or Photoshop 
feature? Please let us know in the comments.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 194



Top Non-Destructive Photoshop 
Techniques
Adrian Taylor

The creative process is not a linear one. As artists and designers, we often 
set off in one direction only to decide that the proper solution lies 
somewhere else completely. Unfortunately, many of the creative 
software packages we use (Photoshop in particular) can be pretty 
unforgiving when in comes to making changes late in the game.

Sure, we’ve got “Undo” for a quick change of heart, but often we don’t 
realize we need to make an adjustment until several steps (or days) later. 
Luckily, Photoshop has some great features built in that allow us to work in 
ways that protect our precious pixels—truly freeing us to do our best work.

In this video article, I’ll show you some of my favorite techniques and tools 
for keeping your files flexible, including Smart Objects, Smart Filters, Layer 
Styles, Adjustment Layers, Masks and more. The approaches shown in this 
video should provide a solid starting point. But like anything in Photoshop, 
there is no “one right way” to approach it. The key is to find the method that 
best supports your workflow!

Click the link to see the video tutorial.

Designing or editing photos is a pretty organic process. Allowing 
yourself to make edits to your document that don’t affect the original 
pixels provide you with a lot of flexibility when making decisions 
throughout your design process.
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Exporting From Photoshop
Marc Edwards

Congratulations. You’ve just completed a pixel-perfect mock-up of an app, 
and you’ve gotten the nod from everyone on the team. All that’s left to do is 
save the tens, hundreds or maybe even thousands of production assets 
required to bring it to life.

It’s probably the least interesting part of designing software, usually entailing 
hours of grinding. Saving images to multiple scales — as required by iOS 
and other platforms — adds complication to the process. But there are ways 
to streamline or automate the exporting process.

Copy Merged
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Cutting up a design with the “Copy Merged” feature is fairly easy: ensure 
that the layers are shown or hidden as needed; draw a Marquee selection 
around the element; choose Edit → Copy Merged, and then File → New; hit 
Return; and then “Paste.” The result is a new document with your item 
isolated, trimmed to the absolute smallest size possible.
From here, all you need to do is save the image using “Save As” or “Save for 
Web & Devices.”

Rinse and repeat for every image needed for the app or website. The 
technique is simple and quick, but repetitive; and if you ever need to export 
the images again, you’ll have to start from scratch.

This seems to be the most common method and, for some designers, the 
only method, which is a shame, because better techniques exist.

You could create an action that triggers the “Copy Merged,” “New,” “Paste” 
process — a small time-saver, but ultimately not much of an improvement to 
the workflow.
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Export Layers to Files

If you’re lucky, and your goal is to export a lot of similar images (typically 
with identical dimensions), you might be able to use Photoshop’s “Export 
Layers to Files” script.

By choosing File → Scripts → Export Layers to Files, each layer of the 
document will be saved as a separate file, with a file name that matches the 
layer’s name. This means you’ll probably have to prepare the document by 
flattening all of the elements that you’d like to export down to bitmap layers 
— a time-consuming process, but often quicker than using “Copy Merged.” It 
could also trim the size of the resulting file, if you choose to remove 
completely transparent areas.

I can’t say that I’m a fan of the script’s Flash-based UI or of the way it works, 
but “Export Layers to Files” is handy if your desired result fits its limited 
range of use cases.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 198



Slices
Photoshop’s Slice tool lets you define rectangular areas to export as 
individual images, with some limitations: only one set of slices can exist per 
document, and slices cannot overlap (if they do, then smaller rectangle 
slices will be formed). During the ’90s, the Slice tool was a good way to 
create table-based Web layouts, filled with images. These days, designers 
far more often need finer control over how images are sliced, especially 
when creating efficient, dynamic designs, typically with images that have 
transparency. But, with a twist on the original concept, the Slice tool can be 
put to great use.

SPRITE SHEETS WITH SLICES

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 199

http://help.adobe.com/en_US/photoshop/cs/using/WSfd1234e1c4b69f30ea53e41001031ab64-7570a.html
http://help.adobe.com/en_US/photoshop/cs/using/WSfd1234e1c4b69f30ea53e41001031ab64-7570a.html


Sprite sheets are commonly used in CSS and OpenGL games, where texture 
atlasing can have significant performance benefits. A similar method can be 
employed to build UI elements in Photoshop, even if the result is a set of 
images, rather than one large image.

By spreading out the elements that you need to export as a flat sprite sheet, 
you eliminate the need for slices to overlap. If there are too many elements 
to comfortably fit in one document, you can create multiple documents, 
eliminating the need for more than one set of slices per document.

The other benefit to working like this is that you’ll no longer need to build 
your main design documents with the same level of precision. Occasionally 
using a bitmap or forgetting to name a layer is fine, because you’ll have a 
chance to fix things when preparing the sprite sheet for exporting. But it 
does mean that the original mock-up document could get out of sync with 
the export documents if you make changes (for example, to adjust colors or 
layer effects).

Because we’re interested only in user-created slices, it might also be a good 
idea to click “Hide Auto Slices” (in the options toolbar when the Slice Select 
tool is enabled) and to turn off “Show Slice Numbers,” under “Guides, Grid & 
Slices” in Preferences. This way, you’ll remove unnecessary clutter from 
Photoshop’s slice UI.
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After you’ve created a sprite sheet with the slices all set up correctly, you’ll 
be able to export all of the images at once, using “Save for Web & Devices.” 
Assuming you’ve done things correctly, you’ll be able to scale up by 200%, 
save all of your Retina images, and then batch rename them (adding @2x to 
the file names) — or scale them down, if you built everything at Retina size to 
begin with.

LAYER-BASED SLICES

If your UI element is one layer and you’d like the exported image to be the 
smallest possible size, you might want to consider using a “Layer-Based 
Slice.” To create one for the currently selected layer, choose “New Layer-
Based Slice” from the Layers menu. A Layer-Based Slices moves, grows and 
shrinks with the layer it’s associated with. It also takes into account layer 
effects: strokes and shadows increase the size of a Layer-Based Slice, so 
the effects are included. Less control, but more automated.
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My Exporting Workflow
For years, I’ve used Copy Merged as my primary exporting method, and 
used Export Layers to Files when it made sense. That was a poor choice. 
Sprite sheets have so many advantages, especially in medium- to large-
scale projects, that the set-up time is made up for very quickly. This is even 
truer when exporting Retina and non-Retina images: each set can be 
exported in a few clicks and is far less likely to have issues with file names 
or sizes due to its automated nature.

It also creates an environment in which modifying production assets is easy, 
allowing for faster iteration and more experimentation. It lowers the barrier 
to improving artwork during development and when revising the app or 
website.

And that’s a very good thing.
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#e Lost Art Of Design Etique!e
Dan Rose

Endless layers in Photoshop. Overstuffed image folders. That jQuery plug-in 
that has 12 files associated with it. Hundreds or thousands of individual 
pieces go into making a website. No wonder we go off the deep end when 
we can’t find a closing div — er, section tag. We work with a ridiculously large 
number of things, and how we organize them (or choose not to) is often left 
to personal preference. But our messy habits result in confusion for the 
designer or developer who inherits your work.

Does it really need to be this way?

Us Vs. #em?
The great divide between designers and developers is well documented. 
Designers complain when developers would rather backgrounds not have 
any images. Developers gripe when given a Photoshop document with 
missing fonts. If those were the only problems we face, we’d be thrilled.

Unfortunately, not every studio is a breeding ground for pixel-crafting 
harmony. Sometimes designers work on one floor, developers on another. If 
you asked a good number of them, they’d say they were content with that 
arrangement. No wonder communication breakdowns are so frequent. The 
only brains we have to pick are those of our fellow designers or fellow 
developers, with little crossover it seems. Proximity doesn’t always improve 
proficiency, but don’t tell that to bees.
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The essence of teamwork. You’ve heard of designer bees and developer bees, 
right?

Web designers have the unique ability to communicate through layout, 
shape, typography and, ultimately, simplicity. That same discipline must be 
exercised internally when sharing their artwork with colleagues — using, 
coincidentally, those same tools. As challenging as it may be, we can bring 
sophistication to our interfaces in Photoshop, so that our artwork achieves 
clarity through order. Just as our client has a target audience, we should 
also be considerate of the internal audience that uses our work.
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We’re nibbling at the edges of websites that deliver a happy marriage 
between remarkable aesthetic and solid function. Seeing some websites 
already achieving that is exciting. But to fill the Web with more of it, 
designers and developers will need to combine their skills in even more 
proficient and efficient ways.

A CALL TO ARMS

Let’s start a revolution that has less to do with being nice and more to do 
with holding one another to higher standards. Let’s get caught up not in the 
sexy pixels of tomorrow, but rather in attention to detail in our workflow. 
What if we made it easier for others to actually use and edit our work? Yes, 
my friends: let’s start an etiquette revolution.

Make better websites, not war. Fist bumps, man hugs and peace signs, people.
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More #an Just Chivalry
Why etiquette? I agree: at first it does sound stuffy and time-consuming, 
especially if what we’ve done has always worked. The client won’t see the 
etiquette, we’ll still get paid, and all is well. But let’s reason here: whether 
you’re in a group or creating websites all by yourself, the level of detail in 
your craft reflects how much you value your profession and should be 
apparent in the finished product.

Even so, internally, inheriting messy artwork can be a point of contention for 
developers. A design could be the most beautiful and useful thing in the 
world, but if it’s not practically built, it will waste precious time and money. 
All of the investigative work of the developer in posing questions to the 
designer about what’s confusing in their PSD should not have been 
necessary; the work should have been clear from the beginning, and the 
designer as organized as ever.

Can both the individual and group benefit from some good ol’ fashioned 
etiquette?

PERSONAL GAIN

Here’s a plain illustration of my point. Think of the designer or developer 
whose work inspires you most. Imagine you had the opportunity to work 
with them on a project. They got the ball rolling with a PSD or a directory of 
coded files, and handed it off to you for editing. How surprised would you be 
if the layers were unnamed? Or the code wasn’t indented, all smushed 
together? You likely wouldn’t see that, right? Every layer, every line of code 
reflects on who they are.
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Even if you’re a one-person shop, holding yourself to high standard of 
organization has always been good practice. By doing so, you make less 
work for yourself when you need to go back to edit something. More 
importantly, if you were ever to pass off a PSD to a developer or client, you’d 
want it to speak to your attention to detail and professionalism.

(Aside to Fireworks users: I’m about to make a ton of references to PSDs, so 
feel free to substitute “Fireworks PNGs.”)

COLLECTIVE GAIN

Have you ever inherited a PSD from a designer and, on seeing the missing 
fonts, unnamed layers and myriad of masks, knew you were in for about four 
hours of work just to get started? No? Must be just me, then.

Indulge me, then. Those hours, even if few, are time spent by someone less 
familiar with the file than the designer and, thus, unnecessary. Our job as 
Web designers is to run a tight PSD ship. In theory, I should be able to 
organize my PSD in a fraction of the time that someone else could, just 
because of my familiarity as the designer. The result? An easier process for 
the inheritor and less time billed for the company.

Equally important, how much less disgruntled would developers be if 
designers handed over their work without so many blunders? How many 
projects would come in under budget? How about world peace? Too far?

Let’s apply the same clarity that we bring to the canvas to the “Layers” 
panel, too. Now we’re on our way to higher standards.

Let’s look at some recurring issues and see how to resolve them.
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Common Mistakes

DIDN’T PUT THE FILE ON THE SERVER

Just your luck. A deadline is fast approaching, and you’ve set aside a good 
amount of your day to plough through editing a PSD that a fellow designer 
has just finished working on. Problem is, you can’t get to it because it’s 
sitting on their desktop instead of the server. How convenient. And doesn’t 
this always happen when they’re on vacation?

If you’re like me, your short-term memory could use a reminder at 5:00 pm daily.

The remedy
Depending on the hardware, designers should work directly off a networked 
server, and use their computers only for local back-ups. Alternatively, you 
could set an alert (in iCal or your app of choice) at the end of each day to 
remind you to commit your files to a shared spot.
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UNNAMED OR UNUSED LAYERS

The developer didn’t expect to need a machete to use your file. Thicker than 
the Amazon rainforest, your PSD has layers-a-plenty, some even with such 
distinguished names as “Layer 0 copy.”

The remedy
Name layers and make folders as you go in Photoshop. Yes, it takes 
discipline, but it’s easier than having to go back to rename and delete after 
the fact. Use folders, too: they’re there for a reason.

Distinguishing “Layer 0” from “Layer 1” is hard. Let’s use our words.

Smashing eBook #31│Mastering Photoshop for Web Design, Volume 3│ 209



UNPURCHASED STOCK PHOTOS

Hello there, Mr. iStockphoto watermark. Curious to see you in the final PSD. 
If we could have only mustered the $3 for credits, I could have gotten rid of 
you myself.

The remedy
For everything, proofread, proofread, proofread. Your text and your images.

Ouch! See what happens when we forget to buy the stock?
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INACCURATE FILE NAMES

You look confused, developer. Clearly, you should be using 
website_LATEST-v3_FINAL.psd instead of 
website_USE_THIS_ONE_ULTIMATE.psd.

The remedy
One file, named accurately. Archive the rest if you think you might need to 
go back to the third of your nine iterations for some reason.

No amount of highlights and descriptions is as good as maintaining a single file 
and archiving the rest.
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MISSING FONTS

Does this sound familiar?

The following fonts are missing for text layer “myFont, notYours”:
Guilty Culprit Extra Condensed

Font substitution will occur. Continue?

Ain’t that something? Confirming wouldn’t be a good solution in this case, 
because then the developer would be doing some guesswork to match the 
font that the designer presumably has more knowledge of. This usually 
happens when a font needs to be used as image text, so a straight 
substitution might not be an option.

The remedy
Ideally, the designer would be considerate enough to include the (licensed) 
font somewhere within arm’s reach of the PSD. Alternatively, the studio 
could install common fonts on all production computers. Apps like Fontcase, 
Suitcase Fusion and Linotype FontExplorer X will manage your fonts for you.

INCONSISTENT OR INACCURATE CONTENT

If I’ve learned anything from working with developers, it’s that they don’t like 
to do things twice. Rightfully so. Whether it’s unpurchased stock photos, 
inconsistent type sizes or inconsistent colors, when they’re not caught the 
first time around, images need to be reproduced and code needs to be 
altered. And sadness overcomes all those involved.

The remedy
Develop a brand guide if one doesn’t exist, and have someone check your 
work before you hand it off. Think of it as quality control.
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Tips And Tools

NAME FILES FOR FUNCTION

Be descriptive but practical when naming PSDs, JPEGs, etc. Something like 
header_bg.jpg is a little more indicative than blue_box.jpg, isn’t it?

CONSERVE FILE SIZE

I may sound like an old curmudgeon, but file size is still pertinent today. 
When exporting images, remember that a background at 80 quality will still 
look close to one at 100 quality but will likely be at least 33% smaller in size. 
Everyone still likes pages that load quickly, even if our Internet connection 
speeds have increased over the years.

SNAP TO PIXELS

When I’m cutting up a PSD, one of the most common things I have to 
negotiate are those 1-pixel semi-transparent lines on the outer edges of 
shapes. The best way to remove them is pretty well cloaked in the vastness 
of Photoshop’s settings. When choosing a shape to draw, such as a 
rectangle, look towards the top of the screen at a row of those same shapes, 
with an arrow at the end of the row. Click that arrow, and you’ll see more 
options. Check the box “Snap to Pixels,” and you’ll see that the shape you 
draw will have much more precise edges.
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USE VERSION CONTROL

A fantastic way to cut down on the chaos of sharing files is to use a version-
control system such as Git or Subversion. You designers, don’t feel that only 
developers can geek out about this. Using some type of revision control for 
our PSDs and other artwork files is equally important, because those files 
tend to get revised and transferred quite a bit. Version control is crucial 
when multiple people are working on front-end and back-end development, 
because overwriting someone’s work when uploading your own is all too 
easy.

COMMUNICATE

The saying “Communication goes both ways” never meant so much as it 
does here. Designers should freely communicate their decisions to 
developers, who themselves should express their concerns about 
programming said decisions. Nothing new, but it just doesn’t happen as 
openly as it should. If you consult with each other frequently, you’re bound 
to have more etiquette.
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BE TEACHABLE

Part of practicing good Web design manners is having the humility to know 
you’re not the best at what you do (except for one of you out there, Mr. Best 
Web Designer). Be open to being educated by other designers, developers 
and fantastic websites such as Think Vitamin Membership and Method & 
Craft. You’ll gain the respect of your co-workers for taking the initiative to 
improve your skill set.

Websites like Method & Craft are invaluable resources in your quest to become a 
Web design hero.
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IMPLEMENT STANDARDS

The best way to force your Web team to adhere to standards is to come up 
with a list of best practices, on that holds each person accountable for their 
PSDs, HTML, CSS and beyond.

Isobar has done some of the work for you with its Code Standards and Best 
Practices.
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The Photoshop Etiquette Manifesto for Web designers was created to give 
both beginner and seasoned designers a crash course in keeping PSDs 
organized and understandable for others. With helpful visual comparisons of 
“Do this” and “Not this,” the website serves as both an educational resource 
and a checklist. With the crown of “Layer Mayor” at stake, why not take more 
pride as the resident PSD pro in your office?

Setting some guidelines in your workplace is key to accountability and 
consistency.
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Moving Forward
Having said all this, it’s encouraging to see more designers learning and 
understanding the process of developers, and vice versa. Some have done 
it out of necessity, such as freelancers who are hybrid designers/developers. 
Others have done it in order to understand their co-workers better, in the 
hope of a better product.

Hopefully, it’s become apparent that being on the same page, especially in 
Web development, is crucial to success. What are you doing to emphasize a 
high standard and clarity in your own craft and to make your team’s job 
easier?
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